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Errata The ADS product may contain references to "HP" or "HPEESOF" such as in file
names and directory names. The business entity formerly known as "HP EEsof" is now part
of Agilent Technologies and is known as "Agilent EEsof". To avoid broken functionality and
to maintain backward compatibility for our customers, we did not change all the names
and labels that contain "HP" or "HPEESOF" references.

Warranty The material contained in this document is provided "as is", and is subject to
being changed, without notice, in future editions. Further, to the maximum extent
permitted by applicable law, Agilent disclaims all warranties, either express or implied,
with regard to this documentation and any information contained herein, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose.
Agilent shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user have a separate written
agreement with warranty terms covering the material in this document that conflict with
these terms, the warranty terms in the separate agreement shall control.

Technology Licenses The hardware and/or software described in this document are
furnished under a license and may be used or copied only in accordance with the terms of
such license. Portions of this product include the SystemC software licensed under Open
Source terms, which are available for download at http://systemc.org/ . This software is
redistributed by Agilent. The Contributors of the SystemC software provide this software
"as is" and offer no warranty of any kind, express or implied, including without limitation
warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be
liable for any damages of any kind including without limitation direct, indirect, special,
incidental and consequential damages, such as lost profits. Any provisions that differ from
this disclaimer are offered by Agilent only.

Restricted Rights Legend U.S. Government Restricted Rights. Software and technical
data rights granted to the federal government include only those rights customarily
provided to end user customers. Agilent provides this customary commercial license in
Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015
(Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial
Computer Software or Computer Software Documentation).

http://systemc.org/
http://systemc.org/
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 Introduction
TDSCDMA_DnLnk_MultiCarrier_TX test bench for TD-SCDMA downlink (base station to
user equipment) transmitter testing provides a way for users to connect to an RF circuit
device under test (RF DUT) and determine its performance by activating various
measurements. This test bench provides signal measurements for power (including CCDF)
and spectrum.

The signal is designed according to 3GPP TS 25 (Release 4).

This TD-SCDMA signal source is compatible with Agilent Signal Studio signal source
software option 411. Details regarding Signal Studio for TD-SCDMA are included at the
website http://www.agilent.com/find/signalstudio .

The RF DUT output signal can be sent to an Agilent ESG RF signal generator.

This test bench includes a DSP section, an RF modulator, RF output source resistance, RF
DUT connection, RF receivers, and DSP measurement blocks, as illustrated in Transmitter
Wireless Test Bench Block Diagram. The generated test signal is sent to the DUT.

 

 Transmitter Wireless Test Bench Block Diagram

The downlink channel subframe structure is illustrated in 12.2 kbps Downlink Channel
Subframe Structure. One frame consists of two subframes. Each subframe consists of 7
time slots (TS), and one downlink pilot time slot (DwPTS), one guard period (GP) and one
uplink pilot time slot (UpPTS). Each time slot can transmit DPCH signals. One subframe
consists of 6400 chips. Because the chip rate is 1.28 MHz, the subframe has a 5msec
duration.

In the example in 12.2 kbps Downlink Channel Subframe Structure, two DPCH signals in
DPCH1 and DPCH2 are transmitted in TS0. The first DPCH bits are modulated by QPSK
and spread by Walsh code of length 16 then transmitted in the slot. The DPCH1 signal is
composed of 88 coded information bits (88 × 16/2 chips) and 144 chips for midamble
sequence plus 16 chips for GP. The DPCH2 signal, with the same modulation and spread
scheme as DPCH1, is composed of 76 coded information bits (76 × 16/2 chips), 8 bits

http://www.agilent.com/find/signalstudio
http://www.agilent.com/find/signalstudio
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(8 × 16/2 chips) for transport format combination indicator (TFCI), 144 chips for
midamble sequence, 4 bits (4 × 16/2 chips) for transmitter power control and
synchronization shift (TPC and SS) plus 16 chips for GP. The total chips for the subframe
is composed of 7 time slots plus 96 chips for DwPTS, 96 chips for GP and 160 chips for
UpPTS and summarized as (88 × 8+144+16) × 7+160+96 × 2=6400 chips.

 

 12.2 kbps Downlink Channel Subframe Structure

 TD-SCDMA RF power delivered into a matched load is the average power delivered in the
selected time slot TS6 in the TD-SCDMA subframe. RF Signal Downlink Envelope shows
the RF envelope for an output signal with 10 dBm power.

 

 RF Signal Downlink Envelope
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 Test Bench Basics
A template is provided for this test bench.

 

 TDSCDMA Downlink MultiCarrier Transmitter Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_DnLnk_MultiCarrier_TX_test ,2.
click OK ; click left to place the template in the schematic window.
An example design using this template is available; from the ADS Main window click
File > Open > Example > TDSCDMA > TDSCDMA_RF_Verification_wrk >
TDSCDMA_DnLnk_MultiCarrier_TX _test.
The basics for using the test bench are:

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that
is suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default
values are typically accepted; otherwise, set values based on your
requirements.
Activate/deactivate measurements based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.

Open and use the TDSCDMA_DnLnk_MultiCarrier_TX_test template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_DnLnk_MultiCarrier_TX_test ,2.
click OK ; click left to place the template in the schematic window.

The test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
TD-SCDMA Wireless Test Benches (adswtbtds).
Set the  Required Parameters2.

Note
Refer to TDSCDMA_DnLnk_MultiCarrier_TX (adswtbtds) for a complete list of parameters for this
test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep= 48.828125
nsec. The value is displayed in the Data Display pages as TimeStep.
WTB_TimeStep = 1/(ChipRate × SamplesPerChip)
where
ChipRate is 1.28MHz
SamplesPerChip is the number of samples per chip
Set FSource, SourcePower, and FMeasurement.

FSource defines the RF frequency for the TD-SCDMA signal input to the RF
DUT.
SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the TD-SCDMA signal
segment.
FMeasurement defines the TDSCDMA RF frequency output from the RF DUT
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to be measured.
Activate/deactivate ( YES / NO ) test bench measurements (refer to3.
TDSCDMA_DnLnk_MultiCarrier_TX (adswtbtds)). At least one measurement must be
enabled from the measurement list:

PowerMeasurement
SpectrumMeasurement

More control of the test bench can be achieved by setting parameters on the Basic4.
Parameters , Signal Parameters , and measurement categories for each activated
measurement. For details, refer to Setting Parameters (adswtbtds).
The RF modulator (shown in the block diagram in Transmitter Wireless Test Bench5.
Block Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters) , GainImbalance, PhaseImbalance,
I_OriginOffset, Q_OriginOffset, and IQ_Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic
Parameters ). The RF output signal source has a 50-ohm (default) output resistance
defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The TX DSP block (shown in the block diagram in Transmitter Wireless Test Bench
Block Diagram) uses other Signal Parameters .
 More control of Circuit Envelope analysis can be achieved by setting Envelope6.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Comsimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
After running a simulation, results will appear in a Data Display window for the7.
measurement. Simulation Measurement Displays (adswtbtds) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 TDSCDMA_DnLnk_MultiCarrier_TX 
This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 

 Symbol

Description TD-SCDMA downlink multi-carrier TX test
Library WTB
Class TSDFTDSCDMA_DnLnk_MultiCarrier_TX
Derived From baseWTB_TX

 Parameters

Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation time
step

1/1.28
MHz/16

 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/1.28e6/SamplesPerChip.

    

FSource Source carrier frequency 1900 MHz  Hz real (0, ∞)

SourcePower Source power dbmtow(-
20.0)

 W real [0, ∞)

FMeasurement Measurement carrier frequency 1900 MHz  Hz real (0, ∞)

MeasurementInfo Available Measurements     

PowerMeasurement Enable power measurements? NO,
YES

YES   enum  

SpectrumMeasurement Enable spectrum measurement?
NO, YES

NO   enum  

BasicParameters       

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor temperature -273.15  Celsius real [-
273.15,
∞)

EnableSourceNoise Enable source thermal noise? NO,
YES

NO   enum  

MeasR Measurement resistance 50 Ohm  Ohm real [10,
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1.0e6]

MirrorSourceSpectrum Mirror source spectrum about
carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum about
carrier? NO, YES

NO   enum  

RF_MirrorFreq Mirror source frequency for
spectrum/envelope measurement?
NO, YES

NO   enum  

MeasMirrorFreq Mirror meas frequency for
spectrum/envelope measurement?
NO, YES

NO   enum  

TestBenchSeed Random number generator seed 1234567   int [0, ∞)

SignalParameters       

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 16 S  int [8, 32]

RRC_FilterLength RRC filter length (chips) 16   int [2, 128]

ActiveTimeslot Active Timeslot: TS0, TS2, TS3,
TS4, TS5, TS6

TS6   enum  

PowerMeasurementParameters       

PowerDisplayPages Power measurement display
pages:

    

PowerSubframes Number of subframes averaged 1   int [0, ∞)

SpectrumMeasurementParameters       

SpecMeasDisplayPages Spectrum measurement display
pages:

    

SpecMeasStart Spectrum measurement start 0.0  sec real [0, ∞)

SpecMeasStop Spectrum measurement stop 5.0 msec  sec real [0, ∞)

SpecMeasSubframes Spectrum measurement
subframes

3   int [0, 100]

SpecMeasResBW Spectrum resolution bandwidth 30 kHz  Hz real [0, ∞)

SpecMeasWindow Window type: none, Hamming
0.54, Hanning 0.50, Gaussian
0.75, Kaiser 7.865, _8510 6.0,
Blackman, Blackman-Harris

none   enum  

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters, Signal Parameters, and measurement categories for the activated
measurements.

Note
For required parameter information, see Set the Required Parameters (adswtbtds).

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
EnableSourceNoise, when set to NO disables the SourceTemp and effectively sets it3.
to -273.15oC (0 Kelvin). When set to YES, the noise density due to SourceTemp is
enabled.
MeasR defines the load resistance for the RF DUT output Meas signal into the test4.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the5.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in6.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in TX test benches (EVM, Constellation, CDP,
PCDE) and results in measurement on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with7.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.
RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out RF signal8.
for RF envelope, ppectrum, ACLR, and occupied bandwidth measurements.
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RF_MirrorFreq is typically set by the user to NO when MirrorSourceSpectrum = NO;
RF_MirrorFreq is typically set by the user to YES when MirrorSourceSpectrum = YES.
Both settings result in viewing the RF_out signal with no spectrum mirroring. Other
settings by the user result in RF_out signal for RF_Envelope and Spectrum
measurements with spectrum mirroring.
MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in RF9.
signal for the RF envelope, spectrum, ACLR, and occupied bandwidth measurements.
MeasMirrorFreq is typically set to NO by the user when the combination of the
MirrorSourceSpectrum value and any signal mirroring in the users RF DUT results in
no spectrum mirroring in the Meas_in signal. MeasMirrorFreq is typically set to YES
by the user when the combination of the MirrorSourceSpectrum and RF DUT results
in spectrum mirroring in the Meas_in signal.
Other settings result in Meas_in signal for RF_Envelope and Spectrum measurements
with spectrum mirroring. The MirrorMeasSpectrum parameter setting has no impact
on the setting or use of the MeasMirrorFreq parameter.

  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
Next, the signal VRF( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip sets the number of samples in a chip.2.
The default value is set to 16 to display settings according to the 3GPP NTDD. It can
be set to a larger value for a simulation frequency bandwidth wider than 16 × 1.28
MHz. It can be set to a smaller value for faster simulation; however, this will result in
lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger
than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 × 1.28
MHz).
RRC_FilterLength sets root raised-cosine (RRC) filter length in chips.3.
The default value is set to 16 to transmit TD-SCDMA downlink signals in time and
frequency domains based on the 3GPP NTDD standard. It can be set to a smaller
value for faster simulation; however, this will result in lower signal fidelity.
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ActiveTimeslot specifies which slot signal in the subframe will be transmitted.4.
Referring to 12.2 kbps Downlink Channel Subframe Structure (adswtbtds), when
ActiveTimeslot=0, TS0 is used.

  

 Power Measurement Parameters

PowerDisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
PowerSubframes sets the number of subframes over which data will be collected.2.
The measurement start time is the time when the first subframe is detected in the3.
measured RF signal. Automatic synchronization by the measurement model avoids
any start-up transient in the Constellation plots. The measurement stop time is this
start time plus PowerSubframes × SubframeTime. SubframeTime is described in Test
Bench Variables for Data Displays.

  

 Spectrum Measurement Parameters

The Spectrum measurement calculates the spectrum of the input signal. Averaging the
spectrum over multiple subframes can be enabled as described in this section.

This measurement is not affected by the MirrorMeasSpectrum parameter. To apply
spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq = YES; to apply
spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq = YES.

In the following, TimeStep denotes the simulation time step and FMeasurement denotes
the measured RF signal characterization frequency.

The measurement outputs the complex amplitude voltage values at the frequencies1.
of the spectral tones. It does not output the power at the frequencies of the spectral
tones. However, one can calculate and display the power spectrum as well as the
magnitude and phase spectrum by using the dBm, mag, and phase functions of the
data display window.
Note that the dBm function assumes a 50-ohm reference resistance; if a different
measurement was used in the test bench, its value can be specified as a second
argument to the dBm function, for example, dBm(SpecMeas, Meas_RefR) where
SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the
resistive load used.
By default, the displayed spectrum extends from FMeasurement - 1/(2×TimeStep) Hz
to FMeasurement + 1/(2×TimeStep) Hz. When FMeasurement < 1/(2×TimeStep),
the default spectrum extends to negative frequencies. The spectral content at these
negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. The negative frequency tones are then displayed on
the positive frequency axis as would happen in an RF spectrum analyzer
measurement instrument. This process may introduce an error in the displayed
frequency for the mirrored tones. The absolute error introduced is less than
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(spectrum frequency step) / 2 (see Effect of Values for SpecMeasStart,
SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW for the definition of
spectrum frequency step).
The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple subframes and average the results to
achieve video averaging (see note 6).
SpecMeasDisplayPages provides information regarding Data Display pages for this2.
measurement. It cannot be changed by the user.
SpecMeasStart sets the start time for collecting input data.3.
SpecMeasStop sets the stop time for collecting input data when SpecMeasSubframes4.
= 0 and SpecMeasResBW = 0.
SpecMeasSubframes sets the number of segments over which data will be collected.5.
SpecMeasResBW sets the resolution bandwidth of the spectrum.6.
Depending on the values of SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and
SpecMeasResBW, the stop time may be adjusted or spectrum video averaging may
occur (or both). The different cases are described in Effect of Values for
SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW.
Referring to Effect of Values for SpecMeasStart, SpecMeasStop, SpecMeasSubframes,
and SpecMeasResBW, let
Start = TimeStep × int((SpecMeasStart/TimeStep) + 0.5)
Stop = TimeStep × int((SpecMeasStop/TimeStep) + 0.5)
(This means Start and Stop are forced to be an integer number of time step
intervals.)
X = normalized equivalent noise bandwidth of the window
Start and Stop times are used for RF_out and Meas_in signal spectrum analyses. The
Meas_in signal is delayed in time from the RF_out signal by the value of the RF DUT
time delay. Therefore, for RF DUT time delay >0, the RF_out and Meas_in signals are
inherently different and spectrum display differences can be expected.
TimeStep and SubframeTime are defined in the Test Bench Variables for Data
Displays section.
Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular
filter. It is the equivalent width of a rectangular filter that passes the same amount of
white noise as the window. Normalized ENBW (NENBW) is ENBW multiplied by the
duration of the signal being windowed. (Refer to note 7 regarding the various window
options and Window Options and Normalized Equivalent Noise Bandwidth regarding
NENBW for the various windows.)

 Effect of Values for SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW  
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Case
1

SpecMeasSubframes = 0
SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case
2

SpecMeasSubframes > 0
SpecMeasResBW = 0
Resultant stop time = Start + SpecMeasSubframes x SubframeTime
For SpecMeasSubframes > 0 and SpecMeasResBW = 0
Video averaging occurs over all segment time intervals
Resultant resolution BW = X /SubframeTime
Resultant spectrum frequency step = 1/SubframeTime
Video averaging status = Yes, when SpecMeasSubframes > 1

Case
3

SpecMeasSubframes = 0
SpecMeasResBW > 0
Resultant stop time = Start + N x SubframeTimeInterval
where
N = int((Stop -Start)/SubframeTimeInterval) + 1
For SpecMeasSubframes = 0 and SpecMeasResBW > 0
Define SubframeTimeInterval = TimeStep x int((X/SpecMeasResBW/TimeStep) + 0.5)
This means SubframeTimeInterval is forced to a value that is an integer number of time step
intervals.
(Stop-Start) time is forced to be an integer number (N) of SubframeTimeIntervals
N has a minimum value of 1
Video averaging occurs over all SubframeTimeIntervals
Resolution bandwidth achieved is ResBW = X / SubframeTimeInterval, which is very close to
SpecMeasResBW but may not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact
integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case
4

SpecMeasSubframes > 0
SpecMeasResBW > 0
Resultant stop time = Start + M x SubframeTimeInterval
where
M = int((SpecMeasSubframes x SubframeTime)/SubframeTimeInterval) + 1
For SpecMeasSubframes > 0 and SpecMeasResBW > 0
Define SubframeTimeInterval = TimeStep x int(( X /SpecMeasResBW/TimeStep) + 0.5)
This means SubframeTimeInterval is forced to a value that is an integer number of time step
intervals.
(Stop-Start) time is forced to be an integer number (M) of the SubframeTimeIntervals
M has a minimum value of 1
Video averaging occurs over all SubframeTimeIntervals
Resolution bandwidth achieved is ResBW = X / SubframeTimeInterval, which is very close to
SpecMeasResBW but may not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact
integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

SpecMeasWindow specifies the window that will be applied to each segment before7.
its spectrum is calculated. Different windows have different properties, affect the
resolution bandwidth achieved, and affect the spectral shape. Windowing is often
necessary in transform-based (chirp-Z, FFT) spectrum estimation in order to reduce
spectral distortion due to discontinuous or non-harmonic signal over the
measurement time interval. Without windowing, the estimated spectrum may suffer
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from spectral leakage that can cause misleading measurements or masking of weak
signal spectral detail by spurious artifacts.
The windowing of a signal in time has the effect of changing its power. The spectrum
measurement compensates for this and the spectrum is normalized so that the power
contained in it is the same as the power of the input signal.
Window Type Definitions:

none

where N is the window size
Hamming 0.54

where N is the window size
Hanning 0.50

where N is the window size
Gaussian 0.75

where N is the window size
Kaiser 7.865

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
8510 6.0 (Kaiser 6.0)

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
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Blackman

where N is the window size
Blackman-Harris

where N is the window size.

 Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant NENBW

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021
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 Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for each
measurement activated.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for TD-SCDMA Wireless
Test Benches (adswtbtds).

 

 Power Measurement

The power measurement shows CCDF curves (not defined in 3GPP standards) for single
carrier and multicarrier before and after DUT signals. Mean and peak power, and peak-to-
average power ratios before and after the DUT are given as shown in Power Measurement
Results.

 

 Power Measurement Results
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 Spectrum Measurement

The spectrum measurement (not defined in 3GPP standards) shows spectrums for single-
and multi-carrier signals before and after the DUT. The spectrum analyzer output contains
complex amplitude voltage values and the dBm(<meas_name>, <ref_r>) expressions can
be used to convert to dBm values. Spectrum for the RF and Meas signals are shown in
Spectrum Measurement Results.

 

 Spectrum Measurement Results

 

 Test Bench Variables for Data Displays

 Reference variables used to set up this test bench are listed in Test Bench Equations
Derived from Test Bench Parameters and Exported to Data Display.

 Test Bench Equations Derived from Test Bench Parameters and Exported to Data Display 
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Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

TimeStep 1/(ChipRate*SamplesPerChip)

SubframeTime 5 msec

ActiveSlot ActiveSlotIndex

NumCarriers 3

NumChannelsPerCarrier 16

Meas_FMeasurement FMeasurement

Meas_R MeasR
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one TD-SCDMA downlink subframe is a function of
SamplesPerChip and ChipRate.
SamplesPerChip = 16
ChipRate = 1.28 Mb/s
Resultant WTB_TimeStep = 48.828125 nsec; SubframeTime = 5 msec; time
points per subframe = 102400
TDSCDMA_DnLnk_MultiCarrier_TX
Measurement

Bursts
Measured

Simulation Time
(sec)

ADS Processes
(MB)

Power 1 144 139

Spectrum 1 301 272

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 Downlink Receiver Adjacent Channel
Selectivity Test
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 Introduction
TDSCDMA_DnLnk_RX_ACS test bench for TD-SCDMA downlink (base station to user
equipment) receiver adjacent channel selectivity testing provides a way for users to
connect to an RF circuit device under test (RF DUT) and determine its ACS performance by
BER measurements.

ACS is a measure of a receiver's ability to receive a wanted signal at its assigned channel
frequency in the presence of an adjacent channel signal. ACS is the ratio of the receiver
filter attenuation on the assigned channel frequency to the receiver filter attenuation on
the adjacent channel frequency.

The signal and measurements in this test bench are designed according to 3GPP TS
34.122 section 6.4.

This TD-SCDMA signal source model is compatible with Agilent Signal Studio software
option 411. Details regarding Signal Studio for TD-SCDMA are included at the website
http://www.agilent.com/find/signalstudio .

This test bench includes a TX DSP section, an RF modulator, RF output source resistance,
an RF DUT connection, RF receivers, and DSP measurement blocks as illustrated in
Receiver Wireless Test Bench Block Diagram. The generated test signal is sent to the DUT.

 

 Receiver Wireless Test Bench Block Diagram

 The TD-SCDMA RF power delivered into a matched load is the average power delivered in
the selected time slot TS0 in the TD-SCDMA subframe. TD-SCDMA Downlink Envelope for
RF Signal shows the RF envelope for an output signal with -91 dBm power.

 

http://www.agilent.com/find/signalstudio
http://www.agilent.com/find/signalstudio
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 TD-SCDMA Downlink Envelope for RF Signal
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 Test Bench Basics
A template is provided for this test bench.

 

 TDSCDMA Downlink Receiver ACS Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_DnLnk_RX_ACS_test , click2.
OK ; click left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > TDSCDMA > TDSCDMA_RF_Verification_wrk >
TDSCDMA_DnLnk_RX_ACS _test.

The basics for using the test bench are:

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is
suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values
are typically accepted; otherwise, set values based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.
Open and use the TDSCDMA_DnLnk_RX_ACS_test template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_DnLnk_RX_ACS_test , click2.
OK ; click left to place the template in the schematic window.

The test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
TD-SCDMA Wireless Test Benches (adswtbtds).
Set the  Required Parameters .2.

Note
Refer to TDSCDMA_DnLnk_RX_ACS (adswtbtds) for a complete list of parameters for this test
bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation technology).
Each technology requires its own simulation time step with time-step coordination
occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with this
DUT. The CE_TimeStep must be set to a value equal to or a submultiple of (less
than) WTB_TimeStep; otherwise, simulation will stop and an error message will be
displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other test
bench parameter values; with default settings WTB_TimeStep= 97.65625 nsec. The
value is displayed in the Data Display pages as TimeStep.
WTB_TimeStep = 1/(ChipRate × SamplesPerChip)
where
ChipRate is 1.28MHz
SamplesPerChip is the number of samples per chip

Set FSource, SourcePower, and FMeasurement.
FSource defines the RF frequency for the TD-SCDMA signal input to the RF
DUT.
SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the TD-SCDMA signal
segment.
FMeasurement defines the RF frequency output from the RF DUT to be
measured.
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More control of the test bench can be achieved by setting parameters on the Basic1.
Parameters , Signal Parameters , and the measurement categories. For details, refer
to Setting Parameters (adswtbtds).
The RF modulator (shown in the block diagram in Receiver Wireless Test Bench Block2.
Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters) , GainImbalance, PhaseImbalance,
I_OriginOffset, Q_OriginOffset, and IQ_Rotation ( Signal Parameters ).
The RF output resistance uses SourceR and SourceTemp ( Basic Parameters ). The RF
output signal source has a 50-ohm (default) output resistance defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The DSP block (shown in the block diagram in Receiver Wireless Test Bench Block
Diagram) uses other Signal Parameters .
 More control of Circuit Envelope analysis can be achieved by setting Envelope3.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
After running a simulation, results will appear in a Data Display window for the4.
measurement. Simulation Measurement Displays (adswtbtds) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 TDSCDMA_DnLnk_RX_ACS 
This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and measurement parameters.

 

 Symbol

Description TD-SCDMA downlink RX ACS
Library WTB
Class TSDFTDSCDMA_DnLnk_RX_ACS
Derived From baseWTB_RX

 Parameters

Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation
time step

1/1.28
MHz/8

 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/1.28e6/SamplesPerChip.

    

FSource Source carrier frequency 1900 MHz  Hz real (0, ∞)

SourcePower Source power dbmtow(-
91.0)

 W real [0, ∞)

FMeasurement Measurement carrier frequency 1900 MHz  Hz real (0, ∞)

BasicParameters       

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor temperature 16.85  Celsius real [-273.15, ∞)

MeasR Measurement resistance 50 Ohm  Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum about
carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum about
carrier? NO, YES

NO   enum  

TestBenchSeed Random number generator
seed

1234567   int [0, ∞)

SignalParameters       

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)
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PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 8 S  int [2, 32]

ActiveTimeslot Active Timeslot: TS0, TS2, TS3,
TS4, TS5, TS6

TS0   enum  

RRC_FilterLength RRC filter length (chips) 12   int [2, 128]

BasicMidambleID Basic midamble index 0   int [0, 127]

MidambleID Midamble index 1   int [1, K]

MaxMidambleShift Max midamble shift 16 K  int {2,
4,6,8,10,12,14,16}

MinSF Minimum spreading factor 16   int {1, 2,4,8,16}

SpreadCode1 Spread code index for first
channel

1   int [0, 15]

SpreadCode2 Spread code index for second
channel

2   int [0, 15]

AdjChSignalParameters       

AdjChFSourceOffset Adjacent channel carrier
frequency offset

1.6 MHz  Hz real [0, ∞)

AdjChPower Adjacent channel power dbmtow(-
54.0)

 W real [0, ∞)

MeasurementParameters       

DisplayPages RX downlink ACS measurement
display pages:

    

StartBlock Start block 1   int [0, 1000]

StopBlock Stop block 50   int [1, 1000]

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Setting Parameters
More control of the test bench can be achieved by setting parameters on the Basic
Parameters, Signal Parameters, Adjacent Channel Selectivity, and measurement
categories.

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
MeasR defines the load resistance for the RF DUT output Meas signal into the test3.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the4.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in5.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in RX text benches and results in measurement
on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with6.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.

  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
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The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
Next, the signal VRF( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip sets the number of samples in a chip.2.
The default value is set to 8 to display settings according to the 3GPP NTDD. It can
be set to a larger value for a simulation frequency bandwidth wider than 8 × 1.28
MHz. It can be set to a smaller value for faster simulation; however, this will result in
lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger
than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 × 1.28
MHz).
ActiveTimeslot specifies which timeslot is active. The ACS measurement is based on3.
this active timeslot.
RRC_FilterLength shows root raised-cosine (RRC) filter length in chips.4.
The default value is set to 12 to transmit TD-SCDMA downlink signals in time and
frequency domains based on the 3GPP NTDD standard. It can be set to a smaller
value for faster simulation; however, this will result in lower signal fidelity.
BasicMidambleID sets the basic midamble code ID. The basic midamble code is used5.
for training sequences for uplink and downlink channel estimation, power
measurements and maintaining uplink synchronization. There are 128 different
sequences; the BasicMidambleID range is 0 to 127. In Signal Studio, Basic Midamble
ID code has the same meaning as this parameter.
MidambleID is the midamble index which specifies which midamble is used in the6.
physical channel.
MaxMidambleShift is the maximum number of different midamble shifts in a cell that7.
can be determined by maximum users in the cell for the current time slot.
MinSF is the minimum spreading factor which can be used by the physical channel.8.
SpreadCode1 and SpreadCode2 set spread code indices for the first and second9.
DPCH, respectively. For this signal source, the spreading factor is 16.

  

 Adjacent Channel Selectivity Parameters

AdjChFSourceOffset is the adjacent channel carrier frequency offset.1.
AdjChPower is the transmit power of the adjacent channel.2.
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 Measurement Parameters

This measurement requires setting the MirrorMeasSpectrum parameter such that there is
an even number of spectrum mirrorings from the combined test bench source and RF
DUT. For example, if MirrorSourceSpectrum = NO and the RF DUT causes its output RF
signal to have spectrum mirroring relative to its input signal, then set MirrorMeasSpectrum
= YES.

DisplayPages provides Data Display page information for this test bench. It cannot be1.
changed by the user.
StartBlock sets the start block. The block is the unit set of TD-SCDMA subframes for2.
processing channel coding. One block contains four subframes. A value of 0 is the
first block.
StopBlock sets the stop block. For example, StopBlock=50 results in a measurement3.
of 51 blocks.
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 Simulation Measurement Displays
After running the simulation, results will be displayed in the Data Display page as shown
in Simulation Results.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for TD-SCDMA Wireless
Test Benches (adswtbtds).

 The BER must be less than 0.001 for a desired input level of -91 dBm with a -54 dBm
adjacent interference as specified for a TD-SCDMA signal with a 12.2 k reference channel.

 

 Simulation Results

 

 Test Bench Variables for Data Displays

 Reference variables used to set up this test bench are listed in Test Bench Parameters
Exported to the Data Display.

 Test Bench Parameters Exported to the Data Display  

Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_SourcePower_dBm 10*log10(SourcePower)+30

RF_SourceTemp SourceTemp in degrees Celcius
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one TD-SCDMA downlink subframe is a function of
SamplesPerChip and ChipRate.
SamplesPerChip = 8
ChipRate = 1.28 Mb/s
Resultant WTB_TimeStep = 97.65625 nsec; SubframeTime = 5 msec; time
points per subframe = 51200

Simulation time and memory requirements:
TDSCDMA_DnLnk_RX
Measurement*

Bursts
Measured

Simulation Time
(sec)

ADS Processes
(MB)

ACS 50 513 112

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 Downlink Transmitter Test
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 Introduction
TDSCDMA_DnLnk_TX text bench for TDSCDMA downlink (base station to user equipment)
transmitter testing provides a way for users to connect to an RF circuit device under test
(RF DUT) and determine its performance by activating various measurements. This test
bench provides signal measurements for RF envelope, constellation, power (including
power vs. time and CCDF), spectrum, and EVM.

The signal and most of the measurements are designed according to 3GPP TS 25 (Release
4).

This TD-SCDMA signal source model is compatible with Agilent Signal Studio software
option 411. Details regarding Signal Studio for TD-SCDMA are included at the website
http://www.agilent.com/find/signalstudio .

The DUT output signal can be sent to an Agilent ESG RF signal generator.

This test bench includes a DSP section, an RF modulator, RF output source resistance, RF
DUT connection, RF receivers, and DSP measurement blocks, as illustrated in Transmitter
Wireless Test Bench Block Diagram. The generated test signal is sent to the DUT.

 

 Transmitter Wireless Test Bench Block Diagram

The downlink channel subframe structure is illustrated in 12.2 kbps Downlink Channel
Subframe Structure. One frame consists of two subframes. Each subframe consists of 7
time slots (TS), and one downlink pilot time slot (DwPTS), one guard period (GP) and one
uplink pilot time slot (UpPTS). Each time slot can transmit DPCH signals. One subframe
consists of 6400 chips. Because the chip rate is 1.28 MHz, the subframe has a 5 msec
duration.

In the example in 12.2 kbps Downlink Channel Subframe Structure, two DPCH signals in
DPCH1 and DPCH2 are transmitted in TS0. The first DPCH bits are modulated by QPSK
and spread by Walsh code of length 16 then transmitted in the slot. The DPCH1 signal is
composed of 88 coded information bits (88 × 16/2 chips) and 144 chips for midamble
sequence plus 16 chips for GP. The DPCH2 signal, with the same modulation and spread

http://www.agilent.com/find/signalstudio
http://www.agilent.com/find/signalstudio
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scheme as DPCH1, is composed of 76 coded information bits (76 × 16/2 chips), 8 bits
(8 × 16/2 chips) for transport format combination indicator (TFCI), 144 chips for
midamble sequence, 4 bits (4 × 16/2 chips) for transmitter power control and
synchronization shift (TPC and SS) plus 16 chips for GP. The total chips for the subframe
is composed of 7 time slots plus 96 chips for DwPTS, 96 chips for GP and 160 chips for
UpPTS and summarized as (88 × 8+144+16) × 7+160+96 × 2=6400 chips.

 

 12.2 kbps Downlink Channel Subframe Structure

 TD-SCDMA RF power delivered into a matched load is the average power delivered in the
selected time slot TS2 in the TD-SCDMA subframe. RF Signal Downlink Envelope shows
the RF envelope for an output signal with 30 dBm power.
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 RF Signal Downlink Envelope
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 Test Bench Basics
A template is provided for this test bench.

 

 TDSCDMA Downlink Transmitter Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_DnLnk_TX_test , click OK ;2.
click left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > TDSCDMA > TDSCDMA_RF_Verification_wrk >
TDSCDMA_DnLnk_TX_test.

The basics for using the test bench are:

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is
suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values
are typically accepted; otherwise, set values based on your requirements.
Activate/deactivate measurements based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.
Open and use the TDSCDMA_DnLnk_TX template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_DnLnk_TX_test , click OK ;2.
click left to place the template in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
TD-SCDMA Wireless Test Benches (adswtbtds).
Set the  Required Parameters2.

Note
Refer to TDSCDMA_DnLnk_TX (adswtbtds) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep= 97.65625
nsec. The value is displayed in the Data Display pages as TimeStep.
WTB_TimeStep = 1/(ChipRate × SamplesPerChip)
where
ChipRate is 1.28MHz
SamplesPerChip is the number of samples per chip
Set FSource, SourcePower, and FMeasurement.

FSource defines the RF frequency for the TD-SCDMA signal input to the RF
DUT.
SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the TD-SCDMA signal
segment.
FMeasurement defines the RF frequency output from the RF DUT to be
measured.

Activate/deactivate ( YES / NO ) test bench measurements (refer to3.
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TDSCDMA_DnLnk_TX (adswtbtds)). At least one measurement must be enabled:
RF_EnvelopeMeasurement
Constellation
PowerMeasurement
SpectrumMeasurement
EVM_Measurement

More control of the test bench can be achieved by setting parameters in the Basic4.
Parameters , Signal Parameters , and measurement categories for each activated
measurement. For details, refer to Setting Parameters (adswtbtds). The RF
modulator (shown in the block diagram in Transmitter Wireless Test Bench Block
Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters) , GainImbalance, PhaseImbalance,
I_OriginOffset, Q_OriginOffset, and IQ_Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic
Parameters ). The RF output signal source has a 50-ohm (default) output resistance
defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The TX DSP block (shown in the block diagram in Transmitter Wireless Test Bench
Block Diagram) uses other Signal Parameters .
 More control of Circuit Envelope analysis can be achieved by setting Envelope5.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
 To send the RF DUT output signal to an Agilent ESG RF signal generator, set6.
parameters on the Signal to ESG category.
For details, refer to Signal to ESG Parameters (adswtbtds).
After running a simulation, results will appear in a Data Display window for the7.
measurement. Simulation Measurement Displays (adswtbtds) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 TDSCDMA_DnLnk_TX
 

This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 

 Symbol

Description TD-SCDMA downlink TX test
Library WTB
Class TSDFTDSCDMA_DnLnk_TX
Derived From baseWTB_TX

 Parameters

Name Description Default Sym Unit Type Range

Required
Parameters

      

CE_TimeStep Circuit envelope simulation
time step

1/1.28 MHz/8  sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/1.28e6/
SamplesPerChip.

    

FSource Source carrier frequency 1900 MHz  Hz real (0, ∞)

SourcePower Source power dbmtow(-
20.0)

 W real [0, ∞)

FMeasurement Measurement carrier
frequency

1900 MHz  Hz real (0, ∞)

MeasurementInfo Available Measurements     

RF_Envelope
Measurement

Enable RF envelope
measurement? NO, YES

YES   enum  

Constellation Enable constellation
measurement? NO, YES

NO   enum  

PowerMeasurement Enable power
measurement? NO, YES

NO   enum  

SpectrumMeasurement Enable spectrum
measurement? NO, YES

NO   enum  
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EVM_Measurement Enable EVM measurement?
NO, YES

NO   enum  

Basic
Parameters

      

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor temperature -273.15  Celsius real [-273.15, ∞)

EnableSourceNoise Enable source thermal
noise? NO, YES

NO   enum  

MeasR Measurement resistance 50 Ohm  Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum about
carrier? NO, YES

NO   enum  

RF_MirrorFreq Mirror source frequency for
spectrum/envelope
measurement? NO, YES

NO   enum  

MeasMirrorFreq Mirror meas frequency for
spectrum/envelope
measurement? NO, YES

NO   enum  

TestBenchSeed Random number generator
seed

1234567   int [0, ∞)

SignalParameters       

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 8 S  int [2, 32]

RRC_FilterLength RRC filter length (chips) 8   int [2, 128]

MidambleAllocScheme Midamble allocation
scheme: UE_Specific,
Common, Default

Common   enum  

BasicMidambleID Basic midamble index 0   int [0, 127]

MidambleID1 1st DPCH midamble index 1   int [1, K]

MidambleID2 2nd DPCH midamble index 2   int [1, K]

MaxMidambleShift Max midamble shift 16 K  int [1, 16]

ActiveTimeslot Active Timeslot: TS0, TS2,
TS3, TS4, TS5, TS6

TS2   enum  

SpreadCode1 1st DPCH spread code index 1   int [1, 16]

SpreadCode2 2nd DPCH spread code
index

2   int [1, 16]

DownlinkPilotCode Downlink pilot code index 0   int [0, 31]

ModPhase Modulation phase
quadruples: S1, S2

S1   enum  

DwPCH_Gain DwPCH gain 1   int (0, ∞)

RF_Envelope
Measurement
Parameters
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RF_EnvelopeDisplayPages RF envelope measurement
display pages:

    

RF_EnvelopeStart RF envelope measurement
start

0.0  sec real [0, ∞)

RF_EnvelopeStop RF envelope measurement
stop

5.0 msec  sec real [0, ∞)

RF_EnvelopeSubframes RF envelope measurement
subframes

1   int [0, 100]

Constellation
Parameters

      

ConstellationDisplayPages Constellation measurement
display pages:

    

ConstellationSubframes Constellation measurement
subframes

3   int [1, 100]

PowerMeasurement
Parameters

      

PowerDisplayPages Power measurement display
pages:

    

PowerSubframeMeasured Subframes measured 3   int [1, ∞)

SpectrumMeasurement
Parameters

      

SpecMeasDisplayPages Spectrum measurement
display pages:

    

SpecMeasStart Spectrum measurement
start

0.0  sec real [0, ∞)

SpecMeasStop Spectrum measurement
stop

5.0 msec  sec real [0, ∞)

SpecMeasSubframes Spectrum measurement
subframes

3   int [0, 100]

SpecMeasResBW Spectrum resolution
bandwidth

0  Hz real [0, ∞)

SpecMeasWindow Window type: none,
Hamming 0.54, Hanning
0.50, Gaussian 0.75, Kaiser
7.865, _8510 6.0,
Blackman, Blackman-Harris

none   enum  

EVM_Measurement
Parameters

      

EVM_DisplayPages EVM measurement display
pages:

    

EVM_StartTime EVM measurement start 0.0  sec real [0, ∞)

EVM_AverageType Average type: Off, RMS
(Video)

RMS (Video)   enum  

EVM_SubframesToAverage Subframes used for RMS
averaging

3   int [1, ∞)

EVM_ActiveSlotThreshold Active slot threshold (dBc) -30.0   real [-120, 0]

SignalToESG
_Parameters

      

EnableESG Enable signal to ESG? NO,
YES

NO   enum  
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ESG_Instrument ESG instrument address [GPIB0:
:19::INSTR]
[localhost]
[4790]

  instrument  

ESG_Start Signal start 0.0  sec real [0, ∞)

ESG_Stop Signal stop 5.0 msec  sec real [(ESG_Start
+60/
1.28e6/S),
(ESG_Start
+32/
1.28/S)]

ESG_Subframes Subframes to ESG 3   int [0, 1000]

ESG_Power ESG RF ouput power (dBm) -20   real (-∞, ∞)

ESG_ClkRef Waveform clock reference:
Internal, External

Internal   enum  

ESG_ExtClkRefFreq External clock reference
freq

10 MHz  Hz real (0, ∞)

ESG_IQFilter IQ filter: through,
filter_2100kHz, filter_40MHz

through   enum  

ESG_SampleClkRate Sequencer sample clock
rate

10.24 MHz  Hz real (0, ∞)

ESG_Filename ESG waveform storage
filename

TDSCDMA_DL   string  

ESG_AutoScaling Activate auto scaling? NO,
YES

YES   enum  

ESG_ArbOn Select waveform and turn
ArbOn after download? NO,
YES

YES   enum  

ESG_RFPowOn Turn RF ON after download?
NO, YES

YES   enum  

ESG_EventMarkerType Event marker type: Neither,
Event1, Event2, Both

Event1   enum  

ESG_MarkerLength ESG marker length 10   int [1, 60]

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Setting Parameters
More control of the test bench can be achieved by setting parameters on the Basic
Parameters, Signal Parameters, and measurement categories for the activated
measurements.

Note
For required parameter information, see TDSCDMA_DnLnk_TX.

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
EnableSourceNoise, when set to NO disables the SourceTemp and effectively sets it3.
to -273.15oC (0 Kelvin). When set to YES, the noise density due to SourceTemp is
enabled.
MeasR defines the load resistance for the RF DUT output Meas signal into the test4.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the5.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in6.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in TX test benches (EVM, Constellation, CDP,
PCDE) and results in measurement on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with7.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.
RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out RF signal8.
for RF envelope, ppectrum, ACLR, and occupied bandwidth measurements.
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RF_MirrorFreq is typically set by the user to NO when MirrorSourceSpectrum = NO;
RF_MirrorFreq is typically set by the user to YES when MirrorSourceSpectrum = YES.
Both settings result in viewing the RF_out signal with no spectrum mirroring. Other
settings by the user result in RF_out signal for RF_Envelope and Spectrum
measurements with spectrum mirroring.
MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in RF9.
signal for the RF envelope, spectrum, ACLR, and occupied bandwidth measurements.
MeasMirrorFreq is typically set to NO by the user when the combination of the
MirrorSourceSpectrum value and any signal mirroring in the users RF DUT results in
no spectrum mirroring in the Meas_in signal. MeasMirrorFreq is typically set to YES
by the user when the combination of the MirrorSourceSpectrum and RF DUT results
in spectrum mirroring in the Meas_in signal.
Other settings result in Meas_in signal for RF_Envelope and Spectrum measurements
with spectrum mirroring. The MirrorMeasSpectrum parameter setting has no impact
on the setting or use of the MeasMirrorFreq parameter.
  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
Next, the signal VRF( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip sets the number of samples in a chip.2.
The default value is set to 8 to display settings according to the 3GPP NTDD. It can
be set to a larger value for a simulation frequency bandwidth wider than 8 × 1.28
MHz. It can be set to a smaller value for faster simulation; however, this will result in
lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger
than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 × 1.28
MHz).
RRC_FilterLength sets root raised-cosine (RRC) filter length in chips.3.
The default value is set to 8 to transmit TD-SCDMA downlink signals in time and
frequency domains based on the 3GPP NTDD standard [1]-[3]. It can be set to a
smaller value for faster simulation; however, this will result in lower signal fidelity.
MidambleAllocScheme is used to select the midamble allocation scheme. There are4.
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three midamble allocation schemes based on the 3GPP NTDD standard [1], [2]. To
set the MidambleAllocScheme parameter based on the 3GPP NTDD standard [1],
related parameters must be set as stated here.

UE specific midamble allocation : a UE specific midamble for uplink and
downlink is explicitly assigned by higher layers.
if MidambleAllocScheme=UE_Specific, BasicMidambleID, MaxMidambleShift, and
MidambleID are used to specify which midamble is exported.
Common midamble allocation : the midamble for downlink is allocated by
layer 1 depending on the number of channelization codes currently present in
the downlink time slot.
if MidambleAllocScheme=Common, only BasicMidambleID and
MaxMidambleShift are used to specify which midamble is exported; the
MidambleID parameter is ignored.
Default midamble allocation : the midamble for uplink and downlink is
assigned by layer 1 depending on the associated channelization code.
if MidambleAllocScheme=Default, only BasicMidambleID and MaxMidambleShift
are used to specify which midamble is exported; the MidambleID parameter is
ignored.

BasicMidambleID sets the basic midamble code ID. The basic midamble code is used5.
for training sequences for uplink and downlink channel estimation, power
measurements and maintaining uplink synchronization. There are 128 different
sequences; the BasicMidambleID range is 0 to 127. In Signal Studio, Basic Midamble
ID code has the same meaning as this parameter.
MidambleID1 and MidambleID2 set the midamble indices for the first and second6.
DPCH, respectively. Midambles of different users active in the same cell and the same
time slot are cyclically shifted versions of one basic midamble code.
Let P = 128, the length of basic midamble and K=MaxMidambleShift, then

W = , is the shift between midambles and 
denotes the largest number less than or equal to x. The MidambleID range is from 1
to MaxMidambleShift.
MidambleID and MaxMidambleShift together correspond to the Midamble Offset
parameter in Signal Studio for Timeslot setup. Midamble Offset = MidambleID × W.
MaxMidambleShift is the maximum number of different midamble shifts in a cell that7.
can be determined by maximum users in the cell for the current time slot.
ActiveTimeslot specifies which slot signal in the subframe will be transmitted.8.
Referring to 12.2 kbps Downlink Channel Subframe Structure (adswtbtds), when
ActiveTimeslot=2, TS2 is used.
SpreadCode1 and SpreadCode2 set spread code indices for the first and second9.
DPCH, respectively. For this signal source, the spreading factor is 16.
In Signal Studio, channelization code for time slot setup has the same meaning as
SpreadCode1 and SpreadCode2.
DownlinkPilotCode sets the downlink pilot synchronization sequence (SYNC-DL).10.
Downlink pilot synchronization is used for DL synchronization and cell initial search.
32 different SYNC-DL code groups are used to distinguish base stations.
DwPTS has 64 chips of a complex SYNC_DL sequence

and 32 chips of guard period. To generate the complex SYNC_DL code, the basic
SYNC_DL code s = s1, s2, ... , s64 is used. There are 32 different basic SYNC_DL
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codes for the entire system. The relation between s and s-is given by:

Therefore, the elements  are alternating real and imaginary.
In Signal Studio, SYNC Code is used to set the downlink pilot code.
ModPhase is used to select the phase quadruples of DwPTS for various phase rotation11.
patterns. In Signal Studio, the Rotation Phase parameter is used to select the phase
quadruples.
Two different phase quadruples S1 and S2 are specified by 3GPP NTDD standard [3]
and described in the following table. A quadruple always starts with an even signal
frame number.
Name Phase Quadruple Description

S1 135, 45, 225, 135 A P-CCPCH is present in the next 4 sub-frames

S2 315, 225, 315, 45 A P-CCPCH is not present in the next 4 sub-frames

DwPCH_Gain sets the gain of DwPCH relative to DPCH. In Signal Studio, there are12.
dialog boxes with dB unit for each DwPCH to set the gain of DwPCH relative to DPCH.
  

 RF Envelope Measurement Parameters

The RF Envelope measurement is not affected by the MirrorMeasSpectrum parameter. To
apply spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq=YES. To
apply spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq=YES.

RF_EnvelopeDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.
RF_EnvelopeStart sets the start time for collecting input data.
RF_EnvelopeStop sets the stop time for collecting input data when
RF_EnvelopeSubframes=0.
RF_EnvelopeSubframes (when > 0) sets the number of bursts over which data will be
collected.
Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and
RF_EnvelopeSubframes, the stop time may be adjusted.
For RF envelope measurement for the RF_out and Meas_in signals:
Let:
Start = TimeStep× (int(RF_EnvelopeStart/TimeStep) + 0.5)
Stop = TimeStep × (int(RF_EnvelopeStop/TimeStep) + 0.5)
This means Start and Stop are forced to be an integer number of time-step intervals.
RF_EnvelopeSubframes Resultant Stop Time

0 Stop

> 0 Start + RF_EnvelopeSubframes x SubframeTime

For the RF envelope of Meas_in to contain at least one complete Subframe, the Stop
value must be set to a minimum of SubframeTime + (RF DUT time delay).
For information about TimeStep and SubframeTime, see Test Bench Variables for
Data Displays.
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 Constellation Parameters

The Constellation measurement requires setting the MirrorMeasSpectrum parameter such
that there is an even number of spectrum mirrorings from the combined test bench source
and RF DUT. For example, if MirrorSourceSpectrum=NO and the RF DUT causes its output
RF signal to have spectrum mirroring relative to its input signal, then set
MirrorMeasSpectrum=YES.

ConstellationDisplayPages provides Data Display page information for this1.
measurement. It cannot be changed by the user.
ConstellationSubframes sets the number of subframes over which data will be2.
collected.
The measurement start time is the time when the first subframe is detected in the3.
measured RF signal. Automatic synchronization by the measurement model avoids
any start-up transient in the Constellation plots.

  

 Power Measurement Parameters

PowerDisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
PowerSubframeMeasured sets the number of subframes over which data will be2.
collected.
The measurement start time is the time when the first subframe is detected in the3.
measured RF signal. Automatic synchronization by the measurement model avoids
any start-up transient in the Constellation plots. The measurement stop time is this
start time plus PowerSubframeMeasured × SubframeTime. SubframeTime is
described in Test Bench Variables for Data Displays.

  

 Spectrum Measurement Parameters

The Spectrum measurement calculates the spectrum of the input signal. Averaging the
spectrum over multiple subframes can be enabled as described in this section.
This measurement is not affected by the MirrorMeasSpectrum parameter. To apply
spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq = YES; to apply
spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq = YES.
In the following, TimeStep denotes the simulation time step and FMeasurement denotes
the measured RF signal characterization frequency.

The measurement outputs the complex amplitude voltage values at the frequencies1.
of the spectral tones. It does not output the power at the frequencies of the spectral
tones. However, one can calculate and display the power spectrum as well as the
magnitude and phase spectrum by using the dBm, mag, and phase functions of the
data display window.
Note that the dBm function assumes a 50-ohm reference resistance; if a different
measurement was used in the test bench, its value can be specified as a second
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argument to the dBm function, for example, dBm(SpecMeas, Meas_RefR) where
SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the
resistive load used.
By default, the displayed spectrum extends from FMeasurement - 1/(2×TimeStep) Hz
to FMeasurement + 1/(2×TimeStep) Hz. When FMeasurement < 1/(2×TimeStep),
the default spectrum extends to negative frequencies. The spectral content at these
negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. The negative frequency tones are then displayed on
the positive frequency axis as would happen in an RF spectrum analyzer
measurement instrument. This process may introduce an error in the displayed
frequency for the mirrored tones. The absolute error introduced is less than
(spectrum frequency step) / 2 (see Effect of Values for SpecMeasStart,
SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW for the definition of
spectrum frequency step).
The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple subframes and average the results to
achieve video averaging (see note 6).
SpecMeasDisplayPages provides information regarding Data Display pages for this2.
measurement. It cannot be changed by the user.
SpecMeasStart sets the start time for collecting input data.3.
SpecMeasStop sets the stop time for collecting input data when SpecMeasSubframes4.
= 0 and SpecMeasResBW = 0.
SpecMeasSubframes sets the number of segments over which data will be collected.5.
SpecMeasResBW sets the resolution bandwidth of the spectrum.6.
Depending on the values of SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and
SpecMeasResBW, the stop time may be adjusted or spectrum video averaging may
occur (or both). The different cases are described in Effect of Values for
SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW.
Referring to Effect of Values for SpecMeasStart, SpecMeasStop, SpecMeasSubframes,
and SpecMeasResBW, let
Start = TimeStep × int((SpecMeasStart/TimeStep) + 0.5)
Stop = TimeStep × int((SpecMeasStop/TimeStep) + 0.5)
(This means Start and Stop are forced to be an integer number of time step
intervals.)
X = normalized equivalent noise bandwidth of the window
Start and Stop times are used for RF_out and Meas_in signal spectrum analyses. The
Meas_in signal is delayed in time from the RF_out signal by the value of the RF DUT
time delay. Therefore, for RF DUT time delay >0, the RF_out and Meas_in signals are
inherently different and spectrum display differences can be expected.
TimeStep and SubframeTime are defined in the Test Bench Variables for Data
Displays section.
Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular
filter. It is the equivalent width of a rectangular filter that passes the same amount of
white noise as the window. Normalized ENBW (NENBW) is ENBW multiplied by the
duration of the signal being windowed. (Refer to note 7 regarding the various window
options and Window Options and Normalized Equivalent Noise Bandwidth regarding
NENBW for the various windows.)

 Effect of Values for SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW  
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Case
1

SpecMeasSubframes = 0
SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case
2

SpecMeasSubframes > 0
SpecMeasResBW = 0
Resultant stop time = Start + SpecMeasSubframes x SubframeTime
For SpecMeasSubframes > 0 and SpecMeasResBW = 0
Video averaging occurs over all segment time intervals
Resultant resolution BW = X /SubframeTime
Resultant spectrum frequency step = 1/SubframeTime
Video averaging status = Yes, when SpecMeasSubframes > 1

Case
3

SpecMeasSubframes = 0
SpecMeasResBW > 0
Resultant stop time = Start + N x SubframeTimeInterval
where
N = int((Stop -Start)/SubframeTimeInterval) + 1
For SpecMeasSubframes = 0 and SpecMeasResBW > 0
Define SubframeTimeInterval = TimeStep x int((X/SpecMeasResBW/TimeStep) + 0.5)
This means SubframeTimeInterval is forced to a value that is an integer number of time step
intervals.
(Stop-Start) time is forced to be an integer number (N) of SubframeTimeIntervals
N has a minimum value of 1
Video averaging occurs over all SubframeTimeIntervals
Resolution bandwidth achieved is ResBW = X / SubframeTimeInterval, which is very close to
SpecMeasResBW but may not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact
integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case
4

SpecMeasSubframes > 0
SpecMeasResBW > 0
Resultant stop time = Start + M x SubframeTimeInterval
where
M = int((SpecMeasSubframes x SubframeTime)/SubframeTimeInterval) + 1
For SpecMeasSubframes > 0 and SpecMeasResBW > 0
Define SubframeTimeInterval = TimeStep x int(( X /SpecMeasResBW/TimeStep) + 0.5)
This means SubframeTimeInterval is forced to a value that is an integer number of time step
intervals.
(Stop-Start) time is forced to be an integer number (M) of the SubframeTimeIntervals
M has a minimum value of 1
Video averaging occurs over all SubframeTimeIntervals
Resolution bandwidth achieved is ResBW = X / SubframeTimeInterval, which is very close to
SpecMeasResBW but may not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact
integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

SpecMeasWindow specifies the window that will be applied to each segment before7.
its spectrum is calculated. Different windows have different properties, affect the
resolution bandwidth achieved, and affect the spectral shape. Windowing is often
necessary in transform-based (chirp-Z, FFT) spectrum estimation in order to reduce
spectral distortion due to discontinuous or non-harmonic signal over the
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measurement time interval. Without windowing, the estimated spectrum may suffer
from spectral leakage that can cause misleading measurements or masking of weak
signal spectral detail by spurious artifacts.
The windowing of a signal in time has the effect of changing its power. The spectrum
measurement compensates for this and the spectrum is normalized so that the power
contained in it is the same as the power of the input signal.
Window Type Definitions:

none

where N is the window size
Hamming 0.54

where N is the window size
Hanning 0.50

where N is the window size
Gaussian 0.75

where N is the window size
Kaiser 7.865

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
8510 6.0 (Kaiser 6.0)

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified
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Bessel function of the first kind
Blackman

where N is the window size
Blackman-Harris

where N is the window size.

 Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant NENBW

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021

  

 EVM Measurement Parameters

The EVM measurement requires setting the MirrorMeasSpectrum parameter such that
there is an even number of spectrum mirrorings from the combined test bench source and
RF DUT. For example, if MirrorSourceSpectrum=NO and the RF DUT causes its output RF
signal to have spectrum mirroring relative to its input signal, then set
MirrorMeasSpectrum=YES.
The EVM measurement provides results for EVM, magnitude error, phase error for one
code channel and for the composite signal. It also provides rho, frequency error, IQ offset,
and gain imbalance.

EVM_DisplayPages provides information regarding Data Display pages for this1.
measurement. It cannot be changed by the user.
Starting at the time instant specified by EVM_StartTime, a signal segment of 10msec2.
is captured and the beginning of a subframe is detected (a 10msec signal segment is
guaranteed to contain a whole subframe). After the subframe is detected, the I and Q
envelopes of the input signal are extracted. The I and Q envelopes are then passed
to a complex algorithm that performs synchronization, demodulation, and EVM
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analysis (this algorithm is the same as the one used in the Agilent 89600 VSA).
If EVM_AverageType is set to Off, only one subframe is detected, demodulated, and3.
analyzed.
If EVM_AverageType is set to RMS (Video), after the first subframe is analyzed the
signal segment corresponding to it is discarded and new signal samples are collected
from the input to fill in the 10msec signal buffer. When the buffer is full again a new
subframe is detected, demodulated, and analyzed. These steps are repeated until
EVM_SubframesToAverage subframes are processed.
If a subframe is mis-detected for any reason, results from its analysis are discarded.
EVM results obtained from all the successfully detected, demodulated, and analyzed
subframes are averaged to give the final averaged results. EVM results from each
successfully analyzed subframe are also recorded (in the variables without the Avg_
prefix in their name).
EVM_ActiveSlotThreshold sets the active slot detection threshold; that is the power4.
level (in dB with respect to the power level of the slot with the largest measured
power) below which a slot will be considered as inactive.

  

 Signal to ESG Parameters

The EVM measurement collects data from the Meas_in signal and downloads it to an
Agilent E4438C Vector Signal Generator. This measurement uses Connection Manager
architecture to communicate with the instrument; parameters specify how data is
interpreted.
Prerequisites for using the Signal to ESG option are:

ESG Vector Signal Generator E4438C; for information, visit the web site
http://www.agilent.com/find/esg .
PC workstation running an instance of the connection manager server.
Supported method of connecting the instrument to your computer through the
Connection Manager architecture; for information, see Connection Manager .

 

 Parameter Information

EnableESG specifies if the signal is downloaded to the ESG instrument. If set to NO,1.
no attempt will be made to communicate with the instrument.
ESG_Instrument specifies a triplet that identifies the VSA resource of the instrument2.
to be used in the simulation, the connection manager server hostname (defaults to
localhost ), and the port at which the connection manager server listens for incoming
requests (defaults to 4790). To ensure that this field is populated correctly, click
Select Instrument , enter the server hostname and port, click OK to see the Remote
Instrument Explorer dialog, select a VSA resource identifier, and click OK . For details
about selecting instruments, see Instrument Discovery in the Wireless Test Bench
Simulation documentation.
ESG_Start and ESG_Stop (when ESG_Subframes=0) specify when to start and stop3.
data collection. The number of samples collected, ESG_Stop - ESG_Start + 1, must

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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be in the range 60 samples to 64 Msamples, where 1 Msample = 1,048,576 samples.
The ESG requires an even number of samples; the last sample will be discarded if
ESG_Stop - ESG_Start + 1 is odd.
ESG_Subframes sets the number of subframes over which data will be collected. If4.
ESG_Subframes is greater than zero, then ESG_Stop is forced to ESG_Start +
ESG_Subframes x SubframeTime where SubframeTime is 5 msec.
ESG_ClkRef specifies an internal or external reference for the ESG clock generator. If5.
set to External, the ESG_ExtClkRefFreq parameter sets the frequency of this clock.
ESG_IQFilter specifies the cutoff frequency for the reconstruction filter that lies6.
between the DAC output and the Dual Arbitrary Waveform Generator output inside
the ESG.
ESG_SampleClkRate sets the sample clock rate for the DAC output.7.
ESG_Filename sets the name of the waveform inside the ESG that will hold the8.
downloaded data.
The ESG driver expects data in the range {-1, 1}. The ESG_AutoScaling parameter9.
specifies whether to scale inputs to fit this range. If set to YES, inputs are scaled to
the range {-1, 1}; if set to NO, raw simulation data is downloaded to the ESG
without any scaling, but data outside the range {-1, 1} is clipped to -1 or 1. If set to
YES, scaling is also applied to data written to the local file (ESG_Filename setting).
If ESG_ArbOn is set to YES, the ESG will start generating the signal immediately after10.
simulation data is downloaded; if set to NO, waveform generation must be turned on
at the ESG front panel.
If ESG_RFPowOn is set to YES, the ESG will turn RF power on immediately after11.
simulation data is downloaded. If ESG_RFPowOn is set to NO (default), RF power
must be turned on at the ESG front panel.
ESG_EventMarkerType specifies which ESG Event markers are enabled: Event1,12.
Event2, Both, or Neither. Event markers are used for synchronizing other instruments
to the ESG. When event markers are enabled, Event1 or Event2 (or both) is set
beginning from the first sample of the downloaded Arb waveform over the range of
points specified by the ESG_MarkerLength parameter. This is equivalent to setting
the corresponding event from the front panel of the ESG.
ESG_MarkerLength specifies the range of points over which the markers must be set13.
starting from the first point of the waveform. Depending on the
ESG_EventMarkerType setting, the trigger length of Event1 or Event2 (or both) is set
to a multiple of the pulsewidth that, in turn, is determined by the sample clock rate
of the DAC output.
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 Simulation Measurement Displays
After running the simulation, results are displayed in Data Display pages for each
measurement activated.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for TD-SCDMA Wireless
Test Benches (adswtbtds).

 

 RF Envelope Measurement

 The RF Envelope measurement (not defined in 3GPP TS 25) shows the envelope of a TD-
SCDMA uplink signal. Measurements for the RF signal at the input of the RF DUT and the
Meas signal at the output of the RF DUT are implemented.
The real and imaginary parts of the RF and Meas signals are shown in RF Envelope
Simulation Results. There are two active parts because ActiveTimeslot is set to TS1 and
uplink pilot is transmitted. Only 2.6msec of data is stored to save disk space; the stop
time can be changed by setting RF_EnvelopeMeasurement parameters.

 

 RF Envelope Simulation Results

 

 Constellation Measurement
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 The constellation measurement (not defined in 3GPP TS 25) shows the constellation of
one code channel of the TD-SCDMA uplink signal. The constellation for the RF and Meas
signals are shown in Signal Constellations. Through the constellation measurement,
distortion caused by carrier phase shift, IQ imbalance, and phase noise can be observed.
Comparing the RF and the Meas signals, the constellation of the Meas signal rotates a
fixed angle due to the delay introduced by the DUT.

QPSK demodulation is implemented in the TD-SCDMA uplink. Symbol mapping is shown in
Symbol Mapping.

 

 Signal Constellations

 Symbol Mapping

*Input <th

00 +j

01 +1

10 -1

11 -j

 

 Power Measurement

 The power measurement includes: power vs. time (defined in 3GPP TS 25.105 [3] and TS
25.142 [4] ); and, CCDF (not defined in 3GPP standards).

Power vs. time is the instant power of chips in the subframe (when
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PowerSubframeMeasured = 1) and average power of chips at the same position in all
measured subframes (when PowerSubframeMeasured > 1). CCDF fully characterizes the
power statistics of a signal and provides characterization of peak-to-average power ratio
versus probability.
The on/off mask template for power vs. time is illustrated in Downlink Transmit On/Off
Mask Template.

Results of power vs. time for the RF and Meas signals are shown in Power vs. Time in One
Subframe; results of power vs. time with masks are shown in RF and Signal Power vs.
Time with Masks.

To show the power vs. time on/off masks more clearly, zoomed-in RF and Meas signals
are shown in RF Signal Power vs. Time with Masks Off and On and Meas Signal Power vs.
Time with Masks Off and On.

If the curves meet the masks, Pass will show in the Data Display window; otherwise,
Failure will show.

 

 Downlink Transmit On/Off Mask Template

 

 Power vs. Time in One Subframe
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 RF and Signal Power vs. Time with Masks

 

 RF Signal Power vs. Time with Masks Off and On

 

 Meas Signal Power vs. Time with Masks Off and On
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The CCDF for the RF and the Meas signals are shown in Complementary Cumulative
Distribution Function.

The peak-to-average power ratios of the RF and Meas signals are shown in Peak-to-
Average Power Ratios.

 

 Complementary Cumulative Distribution Function

 

 Peak-to-Average Power Ratios

 

 Spectrum Measurement

 The spectrum measurement (not defined in 3GPP standards) shows the spectrum of the
TD-SCDMA downlink signal. The spectrum analyzer output contains complex amplitude
voltage values and the dBm(<meas_name>, <ref_r>) expressions can be used to convert
to dBm values. Spectrums for the RF and the Meas signals are shown in TD-SCDMA Signal
Spectrums.
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 TD-SCDMA Signal Spectrums

 

 EVM Measurement

The EVM measurement (defined in 3GPP TS 25.102 and TS 34.122) demonstrates the
uplink EVM measurement. EVM is a measure of the difference between the reference and
the measured waveform; this difference is called the error vector. Both waveforms pass
through a matched root raised-cosine filter with bandwidth corresponding to the
considered chip rate and roll-off a=0.22. Both waveforms are further modified by selecting
the frequency, absolute phase, absolute amplitude, and chip clock timing so as to
minimize the error vector. The EVM result is defined as the square root of the ratio of the
mean error vector power to the mean reference power expressed as a percent. The
measurement interval is one timeslot. The EVM must not exceed 12.5%. The requirement
is valid over the total power dynamic range as specified in subclause 6.4.3 of TS 25.102.

 The results from this measurement are described in the following table.

 EVM Measurement Results
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Result Description

Avg_ChEVMrms_pct average channel EVM rms in %

ChEVMrms_pct channel EVM rms in % versus subframe

ChEVM_Pk_pct channel peak EVM in % versus subframe

ChEVM_Pk_symbol_idx channel peak EVM symbol index versus subframe

Avg_ChMagErr_rms_pct average channel magnitude error rms in %

ChMagErr_rms_pct channel magnitude error rms in % versus subframe

ChMagErr_Pk_pct channel peak magnitude error in % versus subframe

ChMagErr_Pk_symbol_idx channel peak magnitude error symbol index versus subframe

Avg_ChPhaseErr_deg average channel phase error in degrees

ChPhaseErr_deg channel phase error in degrees versus subframe

ChPhaseErr_Pk_deg channel peak phase error in degrees versus subframe

ChPhaseErr_Pk_symbol_idx channel peak phase error symbol index versus subframe

ChCodePhase_deg channel code phase (phase of the channel code with respect to the pilot) versus
subframe

Avg_CompEVMrms_pct average composite EVM rms in %

CompEVMrms_pct composite EVM rms in % versus subframe

CompEVM_Pk_pct composite peak EVM in % versus subframe

CompEVM_Pk_chip_idx composite peak EVM chip index versus subframe

Avg_CompMagErr_rms_pct average composite magnitude error rms in %

CompMagErr_rms_pct composite magnitude error rms in % versus subframe

CompMagErr_Pk_pct composite peak magnitude error in % versus subframe

CompMagErr_Pk_chip_idx composite peak magnitude error chip index versus subframe

Avg_CompPhaseErr_deg average composite phase error in degrees

CompPhaseErr_deg composite phase error in degrees versus subframe

CompPhaseErr_Pk_deg composite peak phase error in degrees versus subframe

CompPhaseErr_Pk_chip_idx composite peak phase error chip index versus subframe

Avg_Rho average rho

Rho rho versus subframe

Avg_FreqError_Hz average frequency error in Hz

FreqError_Hz frequency error in Hz versus subframe

Avg_IQ_Offset_dB average IQ offset in dB

IQ_Offset_dB IQ offset in dB versus subframe

Avg_QuadErr_deg average quadrature error in degrees

QuadErr_deg quadrature error in degrees versus subframe

Avg_GainImb_dB average IQ gain imbalance in dB

IQ_GainImb_dB IQ gain imbalance in dB versus subframe

If EVM_AverageType is set to RMS (Video), EVM will be measured in
EVM_SubframesToAverage subframes. If EVM_AverageType is set to Off, EVM will be
measured in the first subframe detected. Results named with the Avg_ prefix are results
averaged over the number of subframes specified by the user in
EVM_SubframesToAverage (when EVM_AverageType is set to RMS (Video)). Results that
are not named Avg_ are results versus subframe. RF signal results are shown in RF Signal
Average and Peak EVM; Meas signal results are shown in Meas Signal Average and Peak
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EVM.

 

 RF Signal Average and Peak EVM

 

 Meas Signal Average and Peak EVM

RF signal results for averaged EVM, magnitude error, and phase error of one code channel
and composite channel are shown in RF Signal EVM, Magnitude Error, and Phase Error
Results; Meas signal results are shown in Meas Signal EVM, Magnitude Error, and Phase
Error Results. According to the 3GPP standard, the EVM must not exceed 12.5%; EVM
results for the RF and the Meas signals meet specification requirements.



Advanced Design System 2011.01 - TD-SCDMA Wireless Test Benches

73

 

 RF Signal EVM, Magnitude Error, and Phase Error Results

 

 Meas Signal EVM, Magnitude Error, and Phase Error Results

 

 Test Bench Variables for Data Displays

 Reference variables used to set up this test bench are listed in Test Bench Equations
Derived from Test Bench Parameters and Exported to Data Display.

 Test Bench Equations Derived from Test Bench Parameters and Exported to Data Display  
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Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10 × log10(SourcePower)+30

RF_R SourceR

TimeStep 1/(ChipRate × SamplesPerChip)

ActiveSlot ActiveTimeslot

SubframeTime 5 msec

FilterLength RRC_FilterLength

Meas_FMeasurement FMeasurement

Meas_R MeasR
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one TD-SCDMA downlink subframe is a function of
SamplesPerChip and ChipRate.
SamplesPerChip = 8
ChipRate = 1.28 Mb/s
Resultant WTB_TimeStep = 97.65625 nsec; SubframeTime = 5msec; time
points per subframe = 51200.

Simulation times and memory requirements:
TDSCDMA_DnLnk_TX
Measurement

Bursts
Measured

Simulation Time
(sec)

ADS Processes
(MB)

RF_Envelope 1 14 125

Constellation 3 17 124

Power 3 175 122

Spectrum 3 24 142

EVM 3 13 108

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 References for Downlink Transmitter Test
3GPP TS 25.221, "3rd Generation Partnership Project; Technical Specification Group1.
Radio Access Network; Physical channels and mapping of transport channels onto
physical channels (TDD) (Release 4)," version 4.5.0, June, 2002.
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25221-450.zip ]
3GPP TS 25.223, "3rd Generation Partnership Project; Technical Specification Group2.
Radio Access Network; Spreading and modulation (TDD) (Release 4)," version 4.4.0,
March, 2002.
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25223-440.zip ]
3GPP TS 25.105, "3rd Generation Partnership Project; Technical Specification Group3.
Radio Access Networks; BS Radio transmission and Reception (TDD) (Release 4),"
version 4.5.0, June, 2002.
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25105-450.zip ]
3GPP TS 25.142 V4.5.0 "3rd Generation Partnership Project; Technical Specification4.
Group Radio Access Networks; Base station conformance testing (TDD) (Release 4),"
version 4.5.0, June, 2002.
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25142-450.zip ]
Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform
analysis tasks.
Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.
Setting Automatic Verification Modeling Parameters in the Wireless Test Bench
Simulation documentation explains how to improve simulation speed.

 

http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25221-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25221-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25223-440.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25223-440.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25105-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25105-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25142-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25142-450.zip
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 Measurement Results for Expressions
for TD-SCDMA Wireless Test Benches
Measurement results from a wireless test bench have associated names that can be used
in Expressions. Those expressions can further be used in specifying goals for Optimization
and Monte Carlo/Yield analysis. For details on using expressions, see Measurement
Expressions (expmeas). For details on setting analysis goals using Optimization and Monte
Carlo/Yield analysis, see Tuning, Optimization, and Statistical Design (optstat).

You can use an expression to determine the measurement result independent variable
name and its minimum and maximum values. The following example expressions show
how to obtain these measurement details where MeasResults is the name of the
measurement result of interest:

The Independent Variable Name for this measurement result is obtained by using the
expression
indep(MeasResults)

The Minimum Independent Variable Value for this measurement result is obtained by
using the expression
min(indep(MeasResults))

The Maximum Independent Variable Value for this measurement result is obtained by
using the expression
max(indep(MeasResults))

TDSCDMA_UpLnk_TX Measurement Results (adswtb3g) through
TDSCDMA_DnLnk_RX_ACS Measurement Results (adswtb3g) list the measurement
result names and independent variable name for each test bench measurement.
Expressions defined in a MeasEqn block must use the full Measurement Results Name
listed. Expressions used in the Data Display may omit the leading test bench name.
You can also locate details on the measurement result minimum and maximum
independent variable values by

Referring to the measurement parameter descriptions when they are available (not
all measurement parameter descriptions identify these minimum and maximum
values).
Observing the minimum and maximum independent variable values in the Data
Display for the measurement.
 

 TDSCDMA_UpLnk_TX Measurement Results

Measurement Results Name Independent Variable Name

Envelope

TDSCDMA_UpLnk_TX.RF_V time

TDSCDMA_UpLnk_TX.Meas_V time

Constellation



Advanced Design System 2011.01 - TD-SCDMA Wireless Test Benches

78

TDSCDMA_UpLnk_TX.ConstellationRF.Constellation Index

TDSCDMA_UpLnk_TX.ConstellationMeas.Constellation Index

Power

TDSCDMA_UpLnk_TX.PowerRF.CCDF.CCDF Index

TDSCDMA_UpLnk_TX.PowerRF.CCDF.MeanPower_dBm Index

TDSCDMA_UpLnk_TX.PowerRF.CCDF.PeakPower_dBm Index

TDSCDMA_UpLnk_TX.PowerRF.CCDF.SignalRange_dB Index

TDSCDMA_UpLnk_TX.PowerRF.Power.AverageTotalPower Index

TDSCDMA_UpLnk_TX.PowerRF.Power.PowerVsTime Index

TDSCDMA_UpLnk_TX.PowerMeas.CCDF.CCDF Index

TDSCDMA_UpLnk_TX.PowerMeas.CCDF.MeanPower_dBm Index

TDSCDMA_UpLnk_TX.PowerMeas.CCDF.PeakPower_dBm Index

TDSCDMA_UpLnk_TX.PowerMeas.CCDF.SignalRange_dB Index

TDSCDMA_UpLnk_TX.PowerMeas.Power.AverageTotalPower Index

TDSCDMA_UpLnk_TX.PowerMeas.Power.PowerVsTime Index

Spectrum

TDSCDMA_UpLnk_TX.SpecRF freq

TDSCDMA_UpLnk_TX.SpecMeas freq

EVM

TDSCDMA_UpLnk_TX.EVM_RF.Avg_ChEVMrms_pct Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_ChMagErr_rms_pct Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_ChPhaseErr_deg Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_CompEVMrms_pct Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_CompMagErr_rms_pct Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_CompPhaseErr_deg Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_FreqError_Hz Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_GainImb_dB Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_IQ_Offset_db Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_QuadErr_deg Index

TDSCDMA_UpLnk_TX.EVM_RF.Avg_Rho Index

TDSCDMA_UpLnk_TX.EVM_RF.ChCodePhase_deg Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChEVMrms_pct Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChEVM_Pk_pct Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChEVM_Pk_symbols_idx Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChMagErr_Pk_pct Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChMagErr_Pk_symbols_idx Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChMagErr_rms_pct Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChPhaseErr_deg Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChPhaseErr_Pk_deg Subframe

TDSCDMA_UpLnk_TX.EVM_RF.ChPhaseErr_Pk_Symbols_idx Subframe



Advanced Design System 2011.01 - TD-SCDMA Wireless Test Benches

79

TDSCDMA_UpLnk_TX.EVM_RF.CompEVMrm_pct Subframe

TDSCDMA_UpLnk_TX.EVM_RF.CompEVM_Pk_chip_idx Subframe

TDSCDMA_UpLnk_TX.EVM_RF.CompEVM_Pk_pct Subframe

TDSCDMA_UpLnk_TX.EVM_RF.CompMagErr_Pk_chip_idx Subframe

TDSCDMA_UpLnk_TX.EVM_RF.CompMagErr_Pk_pct Subframe

TDSCDMA_UpLnk_TX.EVM_RF.CompMagErr_rms_pct Subframe

TDSCDMA_UpLnk_TX.EVM_RF.CompPhaseErr_deg Subframe

TDSCDMA_UpLnk_TX.EVM_RF.CompPhaseErr_Pk_chip_idx Subframe

TDSCDMA_UpLnk_TX.EVM_RF.CompPhaseErr_Pk_deg Subframe

TDSCDMA_UpLnk_TX.EVM_RF.FreqError_Hz Subframe

TDSCDMA_UpLnk_TX.EVM_RF.GainImb_dB Subframe

TDSCDMA_UpLnk_TX.EVM_RF.IQ_Offset_dB Subframe

TDSCDMA_UpLnk_TX.EVM_RF.QuadErr_deg Subframe

TDSCDMA_UpLnk_TX.EVM_RF.Rho Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_ChEVMrms_pct Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_ChMagErr_rms_pct Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_ChPhaseErr_deg Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_CompEVMrms_pct Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_CompMagErr_rms_pct Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_CompPhaseErr_deg Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_FreqError_Hz Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_GainImb_dB Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_IQ_Offset_db Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_QuadErr_deg Index

TDSCDMA_UpLnk_TX.EVM_Meas.Avg_Rho Index

TDSCDMA_UpLnk_TX.EVM_Meas.ChCodePhase_deg Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChEVMrms_pct Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChEVM_Pk_pct Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChEVM_Pk_symbols_idx Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChMagErr_Pk_pct Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChMagErr_Pk_symbols_idx Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChMagErr_rms_pct Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChPhaseErr_deg Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChPhaseErr_Pk_deg Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.ChPhaseErr_Pk_Symbols_idx Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.CompEVMrm_pct Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.CompEVM_Pk_chip_idx Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.CompEVM_Pk_pct Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.CompMagErr_Pk_chip_idx Subframe
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TDSCDMA_UpLnk_TX.EVM_Meas.CompMagErr_Pk_pct Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.CompMagErr_rms_pct Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.CompPhaseErr_deg Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.CompPhaseErr_Pk_chip_idx Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.CompPhaseErr_Pk_deg Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.FreqError_Hz Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.GainImb_dB Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.IQ_Offset_dB Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.QuadErr_deg Subframe

TDSCDMA_UpLnk_TX.EVM_Meas.Rho Subframe

 

 TDSCDMA_DnLnk_TX Measurement Results

Measurement Results Name Independent Variable Name

Envelope

TDSCDMA_DnLnk_TX.RF_V time

TDSCDMA_DnLnk_TX.Meas_V time

Constellation

TDSCDMA_DnLnk_TX.ConstellationRF.Constellation Index

TDSCDMA_DnLnk_TX.ConstellationMeas.Constellation Index

Power

TDSCDMA_DnLnk_TX.PowerRF.CCDF.CCDF Index

TDSCDMA_DnLnk_TX.PowerRF.CCDF.MeanPower_dBm Index

TDSCDMA_DnLnk_TX.PowerRF.CCDF.PeakPower_dBm Index

TDSCDMA_DnLnk_TX.PowerRF.CCDF.SignalRange_dB Index

TDSCDMA_DnLnk_TX.PowerRF.Power.AverageTotalPower Index

TDSCDMA_DnLnk_TX.PowerRF.Power.PowerVsTime Index

TDSCDMA_DnLnk_TX.PowerMeas.CCDF.CCDF Index

TDSCDMA_DnLnk_TX.PowerMeas.CCDF.MeanPower_dBm Index

TDSCDMA_DnLnk_TX.PowerMeas.CCDF.PeakPower_dBm Index

TDSCDMA_DnLnk_TX.PowerMeas.CCDF.SignalRange_dB Index

TDSCDMA_DnLnk_TX.PowerMeas.Power.AverageTotalPower Index

TDSCDMA_DnLnk_TX.PowerMeas.Power.PowerVsTime Index

Spectrum

TDSCDMA_DnLnk_TX.SpecRF freq

TDSCDMA_DnLnk_TX.SpecMeas freq

EVM

TDSCDMA_DnLnk_TX.EVM_RF.Avg_ChEVMrms_pct Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_ChMagErr_rms_pct Index
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TDSCDMA_DnLnk_TX.EVM_RF.Avg_ChPhaseErr_deg Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_CompEVMrms_pct Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_CompMagErr_rms_pct Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_CompPhaseErr_deg Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_FreqError_Hz Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_GainImb_dB Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_IQ_Offset_db Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_QuadErr_deg Index

TDSCDMA_DnLnk_TX.EVM_RF.Avg_Rho Index

TDSCDMA_DnLnk_TX.EVM_RF.ChCodePhase_deg Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChEVMrms_pct Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChEVM_Pk_pct Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChEVM_Pk_symbols_idx Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChMagErr_Pk_pct Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChMagErr_Pk_symbols_idx Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChMagErr_rms_pct Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChPhaseErr_deg Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChPhaseErr_Pk_deg Subframe

TDSCDMA_DnLnk_TX.EVM_RF.ChPhaseErr_Pk_Symbols_idx Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompEVMrm_pct Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompEVM_Pk_chip_idx Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompEVM_Pk_pct Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompMagErr_Pk_chip_idx Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompMagErr_Pk_pct Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompMagErr_rms_pct Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompPhaseErr_deg Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompPhaseErr_Pk_chip_idx Subframe

TDSCDMA_DnLnk_TX.EVM_RF.CompPhaseErr_Pk_deg Subframe

TDSCDMA_DnLnk_TX.EVM_RF.FreqError_Hz Subframe

TDSCDMA_DnLnk_TX.EVM_RF.GainImb_dB Subframe

TDSCDMA_DnLnk_TX.EVM_RF.IQ_Offset_dB Subframe

TDSCDMA_DnLnk_TX.EVM_RF.QuadErr_deg Subframe

TDSCDMA_DnLnk_TX.EVM_RF.Rho Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_ChEVMrms_pct Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_ChMagErr_rms_pct Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_ChPhaseErr_deg Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_CompEVMrms_pct Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_CompMagErr_rms_pct Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_CompPhaseErr_deg Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_FreqError_Hz Index
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TDSCDMA_DnLnk_TX.EVM_Meas.Avg_GainImb_dB Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_IQ_Offset_db Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_QuadErr_deg Index

TDSCDMA_DnLnk_TX.EVM_Meas.Avg_Rho Index

TDSCDMA_DnLnk_TX.EVM_Meas.ChCodePhase_deg Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChEVMrms_pct Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChEVM_Pk_pct Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChEVM_Pk_symbols_idx Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChMagErr_Pk_pct Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChMagErr_Pk_symbols_idx Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChMagErr_rms_pct Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChPhaseErr_deg Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChPhaseErr_Pk_deg Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.ChPhaseErr_Pk_Symbols_idx Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompEVMrm_pct Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompEVM_Pk_chip_idx Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompEVM_Pk_pct Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompMagErr_Pk_chip_idx Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompMagErr_Pk_pct Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompMagErr_rms_pct Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompPhaseErr_deg Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompPhaseErr_Pk_chip_idx Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.CompPhaseErr_Pk_deg Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.FreqError_Hz Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.GainImb_dB Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.IQ_Offset_dB Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.QuadErr_deg Subframe

TDSCDMA_DnLnk_TX.EVM_Meas.Rho Subframe

 

 TDSCDMA_DnLnk_MultiCarrier_TX Measurement Result
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Measurement Results Name Independent Variable Name

Power

TDSCDMA_DnLnk_MultiCarrier_TX.RF_Power.CCDF Index

TDSCDMA_DnLnk_MultiCarrier_TX.RF_Power.MeanPower_dBm Index

TDSCDMA_DnLnk_MultiCarrier_TX.RF_Power.PeakPower_dBm Index

TDSCDMA_DnLnk_MultiCarrier_TX.RF_Power.SignalRange_dB Index

TDSCDMA_DnLnk_MultiCarrier_TX.Meas_Power.CCDF Index

TDSCDMA_DnLnk_MultiCarrier_TX.Meas_Power.MeanPower_dBm Index

TDSCDMA_DnLnk_MultiCarrier_TX.Meas_Power.PeakPower_dBm Index

TDSCDMA_DnLnk_MultiCarrier_TX.Meas_Power.SignalRange_dB Index

TDSCDMA_DnLnk_MultiCarrier_TX.SC_Power.CCDF Index

TDSCDMA_DnLnk_MultiCarrier_TX.SC_Power.MeanPower_dBm Index

TDSCDMA_DnLnk_MultiCarrier_TX.SC_Power.PeakPower_dBm Index

TDSCDMA_DnLnk_MultiCarrier_TX.SC_Power.SignalRange_dB Index

Spectrum

TDSCDMA_DnLnk_MultiCarrier_TX.RF_Spectrum freq

TDSCDMA_DnLnk_MultiCarrier_TX.Meas_Spectrum freq

TDSCDMA_DnLnk_MultiCarrier_TX.SC_Spectrum freq

 

 TDSCDMA_UpLnk_RX_Sensitivity Measurement Results

Measurement Results Name Independent Variable Name

RX Sensitivity

TDSCDMA_UpLnk_RX_Sensitivity.Meas_BER Index

 

 TDSCDMA_DnLnk_RX_ACS Measurement Results

Measurement Results Name Independent Variable Name

RX ACR

TDSCDMA_DnLnk_RX_ACS.Meas_BER Index

  



Advanced Design System 2011.01 - TD-SCDMA Wireless Test Benches

84

 RF DUT Limitations for TD-SCDMA
Wireless Test Benches
This section describes test bench use with typical RF DUTs, improving test bench
performance when certain RF DUT types are used, and improving simulation fidelity. Two
sections regarding special attention for Spectum and EVM transmission measurements is
also included.

The RF DUT, in general, may be a circuit design with any combination and quantity of
analog and RF components, transistors, resistors, capacitors, etc. suitable for simulation
with the Circuit Envelope simulator. More complex RF circuits will take more time to
simulate and will consume more memory.

Test bench simulation time and memory requirements can be considered to be the
combination of the requirements for the baseline test bench measurement with the
simplest RF circuit plus the requirements for a Circuit Envelope simulation for the RF DUT
of interest.

An RF DUT connected to a wireless test bench can generally be used with the test bench
to perform default measurements by setting the test bench Required Parameters . Default
measurement parameter settings can be used (exceptions described below), for a typical
RF DUT that:

Requires an input (RF) signal with constant RF carrier frequency.
The test bench RF signal source output does not produce an RF signal whose RF
carrier frequency varies with time. However, the test bench will support an output
(RF) signal that contains RF carrier phase and frequency modulation as can be
represented with suitable I and Q envelope variations on a constant RF carrier
frequency.
Produces an output (Meas) signal with constant RF carrier frequency.
The test bench input (Meas) signal must not contain a carrier frequency whose
frequency varies with time. However, the test bench will support an input (Meas)
signal that contains RF carrier phase noise or contains time varying Doppler shifts of
the RF carrier. These signal perturbations are expected to be represented with
suitable I and Q envelope variations on a constant RF carrier frequency.
Requires an input (RF) signal from a signal generator with a 50-ohm source
resistance. Otherwise, set the SourceR parameter value in the Basic Parameters tab.
Requires an input (RF) signal with no additive thermal noise (TX test benches) or
source resistor temperature set to 16.85o C (RX test benches). Otherwise, set the
SourceTemp (TX and RX test benches) and EnableSourceNoise (TX test benches)
parameters in the Basic Parameters tab.
Requires an input (RF) signal with no spectrum mirroring. Otherwise, set the
MirrorSourceSpectrum parameter value in the Basic Parameters tab.
Produces an output (Meas) signal that requires a 50-ohm external load resistance.
Otherwise, set the MeasR parameter value in the Basic Parameters tab.
Produces an output (Meas) signal with no spectrum mirroring. Otherwise, set the
MirrorMeasSpectrum parameter value in the Basic Parameters tab.
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Relies on the test bench for any measurement-related bandpass signal filtering of the
RF DUT output (Meas) signal.

When the RF DUT contains a bandpass filter with bandwidth that is on the order
of the test bench receiver system (~1 times the test bench receiver bandwidth)
and the user wants a complete characterization of the RF DUT filter, the default
time CE_TimeStep must be set smaller.
When the RF DUT bandpass filter is much wider than the test bench receiver
system (>2 times the test bench receiver bandwidth), the user may not want to
use the smaller CE_TimeStep time step to fully characterize it because the user
knows the RF DUT bandpass filter has little or no effect in the modulation
bandwidth in this case.

 

 Improving Test Bench Performance

This section provides information regarding improving test bench performance when
certain RF DUT types are used.

Analog/RF models (TimeDelay and all transmission line models) used with Circuit
Envelope simulation that perform linear interpolation on time domain waveforms for
modeling time delay characteristics that are not an integer number of CE_TimeStep
units. Degradation is likely in some measurements, especially EVM.
This limitation is due to the linear interpolation between two successive simulation
time points, which degrades waveform quality and adversely affects EVM
measurements.
To avoid this kind of simulator-induced waveform quality degradation: avoid use of
Analog/RF models that rely on linear interpolation on time domain characteristics; or,
reduce the test bench CE_TimeStep time step by a factor of 4 below the default
CE_TimeStep (simulation time will be 4 times longer).

Analog/RF lumped components (R, L, C) used to provide bandpass filtering with a
bandwidth as small as the wireless signal RF information bandwidth are likely to
cause degradation in some measurements, especially Spectrum. These circuit filters
require much smaller CE_TimeStep values than would otherwise be required for RF
DUT circuits with broader bandwidths.
This limitation is due to the smaller Circuit Envelope simulation time steps required to
resolve the differential equations for the L, C components when narrow RF
bandwidths are involved. Larger time steps degrade the resolution of the simulated
bandpass filtering effects and do not result in accurate frequency domain
measurements, especially Spectrum and EVM measurements (when the wireless
technology is sensitive to frequency domain distortions).
To determine that your lumped component bandwidth filter requires smaller
CE_TimeStep, first characterize your filter with Harmonic Balance simulations over
the modulation bandwidth of interest centered at the carrier frequency of interest.
Though it is difficult to identify an exact guideline on the Circuit Envelope time step
required for good filter resolution, a reasonable rule is to set the CE_TimeStep to
1/(double-sided 3dB bandwidth)/32.
To avoid this kind of simulator-induced waveform quality degradation, avoid the use
of R, L, C lumped filters with bandwidths as narrow as the RF signal information
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bandwidth, or reduce the CE_TimeStep.

Analog/RF data-based models (such as S-parameters and noise parameters in S2P
data files) used to provide RF bandpass filtering with a bandwidth as small as 1.5
times the wireless signal RF information bandwidth are likely to cause degradation in
some measurements, especially EVM.
This limitation is due to causal S-parameter data about the signal carrier frequency
requiring a sufficient number of frequency points within the modulation bandwidth;
otherwise, the simulated data may cause degraded signal waveform quality. In
general, there should be more than 20 frequency points in the modulation
bandwidth; more is required if the filter that the S-parameter data represents has
fine-grain variations at small frequency steps.
To avoid this kind of simulator-induced waveform quality degradation, avoid the use
of data-based models with bandwidths as narrow as the RF signal information
bandwidth, or increase the number of frequency points in the data file within the
modulation bandwidth and possibly also reduce the CE_TimeStep simulation time
step.

An additional limitation exists when noise data is included in the data file. Circuit
Envelope simulation technology does not provide frequency-dependent noise within
the modulation bandwidth for this specific case when noise is from a frequency
domain data file. This may result in output noise power that is larger than expected;
if the noise power is large enough, it may cause degraded signal waveform quality.
To avoid this kind of simulator-induced waveform quality degradation avoid the use
of noise data in the data-based models or use an alternate noise model.

 

 Improving Simulation Fidelity

Some RF circuits will provide better Circuit Envelope simulation fidelity if the CE_TimeStep
is reduced.

In general, the default setting of the test bench SamplesPerChip provides adequate
wireless signal definition and provides the WTB_TimeStep default value.
Set CE_TimeStep = 1/(1.28e6×SamplesPerChip×N)
where N is an integer ≥ 1
When CE_TimeStep is less than the WTB_TimeStep (i.e., N>1), the RF signal to the
RF DUT is automatically upsampled from the WTB_TimeStep and the RF DUT output
signal is automatically downsampled back to the WTB_TimeStep. This sampling
introduces a time delay to the RF DUT of 10×WTB_TimeStep and a time delay of the
measured RF DUT output signal of 20×WTB_TimeStep relative to the measured RF
signal sent to the RF DUT prior to its upsampling.

 

 Special Attention for Spectrum Measurements

The Spectrum Measurement spectrum may have a mask against which the spectrum must
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be lower in order to pass the wireless specification. The Spectrum measurement itself is
based on DSP algorithms that result in as much as 15 dB low-level spectrum variation at
frequencies far from the carrier.

To reduce this low-level spectrum variation, a moving average can be applied to the
spectrum using the moving_average(<data>, 20) measurement expression for a 20-point
moving average. This will give a better indication of whether the measured signal meets
the low-level spectrum mask specification at frequencies far from the carrier.

 

 Special Attention for EVM Measurements

For the EVM measurement, the user can specify a start time. The EVM for the initial
wireless segment may be unusually high (due to signal startup transient effects or other
reasons) that cause a mis-detected first frame that the user does not want included in the
RF DUT EVM measurement.

To remove the degraded initial burst EVM values from the RF DUT EVM measurement, set
the EVM_Start to a value greater than or equal to the RF DUT time delay characteristic.
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 Uplink Receiver Sensitivity Test
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 Introduction
TDSCDMA_UpLnk_RX_Sensitivity test bench for TD-SCDMA uplink (user equipment to
base station) receiver reference sensitivity testing provides a way for users to connect to
an RF circuit device under test (RF DUT) and determine its sensitivity performance by BER
measurements. Reference sensitivity is the minimum input power at the receiver antenna
connector at which the BER does exceed a specified value.

The signal and measurements in this test bench are designed according to 3GPP TS
25.142 section 7.2.

This TD-SCDMA signal source model is compatible with Agilent Signal Studio software
option 411. Details regarding Signal Studio for TD-SCDMA are included at the website
http://www.agilent.com/find/signalstudio .

This test bench includes a TX DSP section, an RF modulator, RF output source resistance,
an RF DUT connection, RF receivers, and DSP measurement blocks as illustrated in
Receiver Wireless Test Bench Block Diagram. The generated test signal is sent to the DUT.

 

 Receiver Wireless Test Bench Block Diagram

TD-SCDMA RF power delivered into a matched load is the average power delivered in the
selected time slot TS2 in the TD-SCDMA subframe. RF Signal Uplink Envelope shows the
RF envelope for an output signal with -110 dBm power.

 

http://www.agilent.com/find/signalstudio
http://www.agilent.com/find/signalstudio
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 RF Signal Uplink Envelope
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 Test Bench Basics
A template is provided for this test bench.

 

 TDSCDMA Uplink Receiver Sensitivity Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_UpLnk_RX_Sensitivity_test ,2.
click OK ; click left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > TDSCDMA > TDSCDMA_RF_Verification_wrk >
TDSCDMA_UpLnk_RX_Sensitivity _test.

The basics for using the test bench are:

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is
suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values
are typically accepted; otherwise, set values based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.
Open and use the TDSCDMA_UpLnk_RX_Sensitivity_test template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_UpLnk_RX_Sensitivity_test ,2.
click OK ; click left to place the template in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
TD-SCDMA Wireless Test Benches (adswtbtds).
Set the  Required Parameters2.

Note
Refer to TDSCDMA_UpLnk_RX_Sensitivity (adswtbtds) for a complete list of parameters for this test
bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep= 97.65625
nsec. The value is displayed in the Data Display pages as TimeStep.
WTB_TimeStep = 1/(ChipRate × SamplesPerChip)
where
ChipRate is 1.28MHz
SamplesPerChip is the number of samples per chip
Set FSource, SourcePower, and FMeasurement.

FSource defines the RF frequency for the TD-SCDMA signal input to the RF
DUT.
SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the TD-SCDMA signal
segment.
FMeasurement defines the RF frequency output from the RF DUT to be
measured.
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More control of the test bench can be achieved by setting parameters on the Basic3.
Parameters , Signal Parameters , and measurement categories for each activated
measurement. For details, refer to Setting Parameters (adswtbtds).
The RF modulator (shown in the block diagram in Receiver Wireless Test Bench Block4.
Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters) , GainImbalance, PhaseImbalance, I
OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).
The RF output resistance uses SourceR and SourceTemp ( Basic Parameters ). The RF
output signal source has a 50-ohm (default) output resistance defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The DSP block (shown in the block diagram in Receiver Wireless Test Bench Block
Diagram) uses other Signal Parameters .
 More control of Circuit Envelope analysis can be achieved by setting Envelope5.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
After running a simulation, results will appear in a Data Display window for the6.
measurement. Simulation Measurement Displays (adswtbtds) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 TDSCDMA_UpLnk_RX_Sensitivity 
This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 

 Symbol

Description TD-SCDMA uplink RX sensitivity
Library WTB
Class TSDFTDSCDMA_UpLnk_RX_Sensitivity
Derived From baseWTB_RX

 Parameters
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Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation
time step

1/1.28
MHz/8

 sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/1.28e6/SamplesPerChip.

    

FSource Source carrier frequency 1900 MHz  Hz real (0, ∞)

SourcePower Source power dbmtow(-
110.0)

 W real [0, ∞)

FMeasurement Measurement carrier frequency 1900 MHz  Hz real (0, ∞)

BasicParameters       

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor temperature 16.85  Celsius real [-273.15, ∞)

MeasR Measurement resistance 50 Ohm  Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum about
carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum about
carrier? NO, YES

NO   enum  

TestBenchSeed Random number generator
seed

1234567   int [0, ∞)

SignalParameters       

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 8 S  int [2, 32]

ActiveTimeslot Active Timeslot: TS1, TS2,
TS3, TS4, TS5, TS6

TS1   enum  

RRC_FilterLength RRC filter length (chips) 12   int [2, 128]

BasicMidambleID Basic midamble index 0   int [0, 127]

MidambleID Midamble index 1   int [1, K]

MaxMidambleShift Max midamble shift 16 K  int {2,
4,6,8,10,12,14,16}

MinSF Minimum spreading factor 8   int {1, 2,4,8,16}

SpreadCode Spread code index 1   int [0, 15]

MeasurementParameters       

DisplayPages RX uplink sensitivity
measurement display pages:

    

StartBlock Start block 1   int [0, 1000]

StopBlock Stop block 50   int [1, 1000]

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed
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 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Setting Parameters
More control of the test bench can be achieved by setting parameters on the Basic
Parameters, Signal Parameters, and measurement categories.

Note
For required parameter information, see Set the Required Parameters (adswtbtds).

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
MeasR defines the load resistance for the RF DUT output Meas signal into the test3.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the4.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in5.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in RX text benches and results in measurement
on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with6.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.

  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
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used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
Next, the signal VRF( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip sets the number of samples in a chip.2.
The default value is set to 8 to display settings according to the 3GPP NTDD. It can
be set to a larger value for a simulation frequency bandwidth wider than 8 × 1.28
MHz. It can be set to a smaller value for faster simulation; however, this will result in
lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger
than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 × 1.28
MHz).
ActiveTimeslot specifies which timeslot is active for the sensitivity measurement. For3.
this uplink test bench, set ActiveTimeslot>0.
RRC_FilterLength sets the root raised-cosine (RRC) filter length in chips.4.
The default value is set to 12 to transmit TD-SCDMA downlink signals in time and
frequency domains based on the 3GPP NTDD standard [1]-[3]. It can be set to a
smaller value for faster simulation; however, this will result in lower signal fidelity.
BasicMidambleID sets the basic midamble code ID. The basic midamble code is used5.
for training sequences for uplink and downlink channel estimation, power
measurements and maintaining uplink synchronization. There are 128 different
sequences; the BasicMidambleID range is 0 to 127. In Signal Studio, Basic Midamble
ID code has the same meaning as this parameter.
MidambleID sets the index of midambles for DPCH. Midambles of different users6.
active in the same cell and the same time slot are cyclically shifted versions of one
basic midamble code.
MaxMidambleShift is the maximum number of different midamble shifts in a cell that7.
can be determined by maximum users in the cell for the current time slot.
MinSF is the minimum spreading factor which can be used by the physical channel.8.
SpreadCode sets the spread code index for the DPCH. For this signal source, the9.
spreading factor is 8.
In Signal Studio, Channelization code for Time slot setup has the same meaning as
SpreadCode.

  

 Measurement Parameters
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This measurement requires setting the MirrorMeasSpectrum parameter such that there is
an even number of spectrum mirrorings from the combined test bench source and RF
DUT. For example, if MirrorSourceSpectrum = NO and the RF DUT causes its output RF
signal to have spectrum mirroring relative to its input signal, then set MirrorMeasSpectrum
= YES.

DisplayPages provides Data Display page information for this test bench; it is not1.
user-editable.
StartBlock sets the start block. The block is the unit set of TD-SCDMA subframes for2.
processing channel coding. One block contains four subframes. A value of 0 is the
first block.
StopBlock sets the stop block. For example, StopBlock=50 results in a measurement3.
of 51 blocks.
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 Simulation Measurement Displays
After simulation, BER results are displayed in the Data Display pages as shown in
Simulation Results.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for TD-SCDMA Wireless
Test Benches (adswtbtds).

 The BER must be less than 0.001 for an input level of -110dBm, as specified for a TD-
SCDMA signal with a 12.2k reference channel.

 

 Simulation Results

Parameters used in the Data Display are described in Test Bench Parameters Exported to
Data Display. The EbN0_RF_dB is the local Eb/N0 measured at the input of the RF DUT
and calculated by the following equations:

T = real(RF_SourceTemp) + 273.15
k = Boltzmann's constant
N0_dBm = 10*log10(k * T) + 30
EbN0_RF_dB = real(RF_Power_dBm) - N0_dBm - 10*log10(1280000*2/(2*8))
Local and system Eb/N0 are described in Receiver Eb/No Definitions in the Wirele ss Test
Bench Simulation documentation.

 

 Test Bench Variables for Data Displays

 Test Bench Parameters Exported to Data Display identifies the variables exported to the
data display set in this test bench:

 Test Bench Parameters Exported to Data Display 
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Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_SourcePower_dBm 10*log10(SourcePower)+30

RF_SourceTemp SourceTemp in degrees Celcius
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one TD-SCDMA uplink subframe is a function of
SamplesPerChip and ChipRate.
SamplesPerChip = 8
ChipRate = 1.28 Mb/s
Resultant WTB_TimeStep = 97.65625 nsec; SubframeTime = 5msec; time
points per subframe = 51200.

Simulation times and memory requirements:
TDSCDMA_UpLnk_Rx Bursts Measured Simulation Time (sec) ADS Processes (MB)

Sensitivity 50 412 99

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 Uplink Transmitter Test
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 Introduction
TDSCDMA_UpLnk_TX test bench for TD-SCDMA uplink (user equipment to base station)
transmitter testing provides a way for users to connect to an RF circuit device under test
(RF DUT) and determine its performance by activating various measurements. This test
bench provides signal measurements for RF envelope, constellation, power (including
power vs. time and CCDF), spectrum, and EVM.

The signal and most of the measurements are designed according to 3GPP TS 25 (Release
4).

This TD-SCDMA signal source model is compatible with Agilent Signal Studio software
option 411. Details regarding Signal Studio for TD-SCDMA are included at the website
http://www.agilent.com/find/signalstudio .

The DUT output signal can be sent to an Agilent ESG RF signal generator.

This test bench includes a DSP section, an RF modulator, RF output source resistance, RF
DUT connection, RF receivers, and DSP measurement blocks, as illustrated in Transmitter
Wireless Test Bench Block Diagram. The generated test signal is sent to the DUT.

 

 Transmitter Wireless Test Bench Block Diagram

The uplink channel subframe structure is illustrated in 12.2 kbps Uplink Channel Subframe
Structure. One frame consists of two subframes. Each subframe consists of 7 time slots
(TS), and one downlink pilot time slot (DwPTS), one guard period (GP) and one uplink
pilot time slot (UpPTS). Each time slot can transmit DPCH signals. One subframe consists
of 6400 chips. Because the chip rate is 1.28 MHz, the subframe has a 5msec duration.

In the example in 12.2 kbps Uplink Channel Subframe Structure, one DPCH signal is
transmitted in TS2. The DPCH bits are modulated by QPSK and spread by Walsh code of
length 8 then transmitted in the slot. The DPCH signal is composed of 164 coded
information bits (164 × 8/2 chips), 8 bits (8 × 8/2 chips) for transport format combination
indicator (TFCI), 144 chips for midamble sequence, 2 bits (2 × 8/2 chips) for transmitter

http://www.agilent.com/find/signalstudio
http://www.agilent.com/find/signalstudio
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power control and 2 bits (2 × 8/2 chips) reserved (TPC and Reserved) plus 16 chips for
GP. The total chips for the subframe is composed of 7 time slots plus 96 chips for DwPTS,
96 chips for GP and 160 chips for UpPTS and summarized as (164 × 4+8 × 4+144+2 ×
4+2 × 4+16) × 7+160+96 × 2=6400 chips.

 

 12.2 kbps Uplink Channel Subframe Structure

 TD-SCDMA RF power delivered into a matched load is the average power delivered in the
selected time slot in the TD-SCDMA subframe. RF Signal Uplink Envelope shows the RF
envelope for an output signal with 10 dBm power.

 

 RF Signal Uplink Envelope
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 Test Bench Basics
A template is provided for this test bench.

 

 TDSCDMA Uplink Transmitter Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_UpLnk_TX_test , click OK ;2.
click left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > TDSCDMA > TDSCDMA_RF_Verification_wrk >
TDSCDMA_UpLnk_TX_test.

The basics for using the test bench are:

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is
suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values
are typically accepted; otherwise, set values based on your requirements.
Activate/deactivate measurements based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.
Open and use the TDSCDMA_UpLnk_TX template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose TDSCDMA_UpLnk_TX_test , click OK ;2.
click left to place the template in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
TD-SCDMA Wireless Test Benches (adswtbtds).
Set the  Required Parameters2.

Note
Refer to TDSCDMA_UpLnk_TX (adswtbtds) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using ADS Ptolemy Data Flow
simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep= 97.65625
nsec. The value is displayed in the Data Display pages as TimeStep.
WTB_TimeStep = 1/(ChipRate × SamplesPerChip)
where
ChipRate is 1.28MHz
SamplesPerChip is the number of samples per chip
Set FSource, SourcePower, and FMeasurement.
FSource defines the RF frequency for the TD-SCDMA signal input to the RF DUT.
SourcePower defines the power level for FSource. SourcePower is defined as the
average power during the non-idle time of the TD-SCDMA signal segment.
FMeasurement defines the RF frequency output from the RF DUT to be
measured.

Activate/deactivate ( YES / NO ) test bench measurements (refer to3.
TDSCDMA_UpLnk_TX (adswtbtds)). At least one measurement must be enabled:

RF_EnvelopeMeasurement
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Constellation
PowerMeasurement
SpectrumMeasurement
EVM_Measurement

More control of the test bench can be achieved by setting Basic Parameters , Signal4.
Parameters , and parameters for each activated measurement. For details, refer to
Setting Parameters (adswtbtds).
The RF modulator (shown in the block diagram in Transmitter Wireless Test Bench5.
Block Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters) , GainImbalance, PhaseImbalance,
I_OriginOffset, Q_OriginOffset, and IQ_Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic
Parameters ). The RF output signal source has a 50-ohm (default) output resistance
defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The TX DSP block (shown in the block diagram in Transmitter Wireless Test Bench
Block Diagram) uses other Signal Parameters .
 More control of Circuit Envelope analysis can be achieved by setting Envelope6.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
 To send the RF DUT output signal to an Agilent ESG RF signal generator, set Signal7.
to ESG Parameters .
For details, refer to Signal to ESG Parameters (adswtbtds).
After running a simulation, results will appear in a Data Display window for the8.
measurement. Simulation Measurement Displays (adswtbtds) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 TDSCDMA_UpLnk_TX
 

This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 

 Symbol

Description TD-SCDMA uplink TX test
Library WTB
Class TSDFTDSCDMA_UpLnk_TX
Derived From baseWTB_TX

 Parameters

Name Description Default Sym Unit Type Range

Required
Parameters

      

CE_TimeStep Circuit envelope simulation
time step

1/1.28 MHz/8  sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/1.28e6/
SamplesPerChip.

    

FSource Source carrier frequency 1900 MHz  Hz real (0, ∞)

SourcePower Source power dbmtow(-
20.0)

 W real [0, ∞)

FMeasurement Measurement carrier
frequency

1900 MHz  Hz real (0, ∞)

MeasurementInfo Available Measurements     

RF_Envelope
Measurement

Enable RF envelope
measurement? NO, YES

YES   enum  

Constellation Enable constellation
measurement? NO, YES

NO   enum  

PowerMeasurement Enable power
measurement? NO, YES

NO   enum  

SpectrumMeasurement Enable spectrum
measurement? NO, YES

NO   enum  

EVM_Measurement Enable EVM measurement? NO   enum  
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NO, YES

BasicParameters       

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor temperature -273.15  Celsius real [-273.15, ∞)

EnableSourceNoise Enable source thermal
noise? NO, YES

NO   enum  

MeasR Measurement resistance 50 Ohm  Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum about
carrier? NO, YES

NO   enum  

RF_MirrorFreq Mirror source frequency for
spectrum/envelope
measurement? NO, YES

NO   enum  

MeasMirrorFreq Mirror meas frequency for
spectrum/envelope
measurement? NO, YES

NO   enum  

TestBenchSeed Random number generator
seed

1234567   int [0, ∞)

SignalParameters       

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 8 S  int [2, 32]

RRC_FilterLength RRC filter length (chips) 12   int [2, 128]

MidambleAllocScheme Midamble allocation
scheme: UE_Specific,
Common, Default

Common   enum  

BasicMidambleID Basic midamble index 0   int [0, 127]

MidambleID Midamble index 1   int [1, K]

MaxMidambleShift Max midamble shift 16 K  int [1, 16]

ActiveTimeslot Active Timeslot: TS1, TS2,
TS3, TS4, TS5, TS6

TS1   enum  

SpreadCode Spread code index 1   int [1, 8]

RF_Envelope
MeasurementParameters

      

RF_EnvelopeDisplayPages RF envelope measurement
display pages:

    

RF_EnvelopeStart RF envelope measurement
start

0.0  sec real [0, ∞)

RF_EnvelopeStop RF envelope measurement
stop

5.0 msec  sec real [0, ∞)

RF_EnvelopeSubframes RF envelope measurement
subframes

1   int [0, 100]

ConstellationParameters       
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ConstellationDisplayPages Constellation measurement
display pages:

    

ConstellationSubframes Constellation measurement
subframes

3   int [1, 100]

PowerMeasurement
Parameters

      

PowerDisplayPages Power measurement display
pages:

    

PowerSubframeMeasured Subframes measured 3   int [1, ∞)

SpectrumMeasurement
Parameters

      

SpecMeasDisplayPages Spectrum measurement
display pages:

    

SpecMeasStart Spectrum measurement
start

0.0  sec real [0, ∞)

SpecMeasStop Spectrum measurement
stop

5.0 msec  sec real [0, ∞)

SpecMeasSubframes Spectrum measurement
subframes

3   int [0, 100]

SpecMeasResBW Spectrum resolution
bandwidth

0  Hz real [0, ∞)

SpecMeasWindow Window type: none,
Hamming 0.54, Hanning
0.50, Gaussian 0.75, Kaiser
7.865, _8510 6.0,
Blackman, Blackman-Harris

none   enum  

EVM_Measurement
Parameters

      

EVM_DisplayPages EVM measurement display
pages:

    

EVM_StartTime EVM measurement start 0.0  sec real [0, ∞)

EVM_AverageType Average type: Off, RMS
(Video)

RMS (Video)   enum  

EVM_SubframesToAverage Subframes used for RMS
averaging

3   int [1, ∞)

EVM_ActiveSlotThreshold Active slot threshold (dBc) -30.0   real [-120, 0]

SignalToESG_Parameters       

EnableESG Enable signal to ESG? NO,
YES

NO   enum  

ESG_Instrument ESG instrument address [GPIB0:
:19::INSTR]
[localhost]
[4790]

  instrument  

ESG_Start Signal start 0.0  sec real [0, ∞)

ESG_Stop Signal stop 5.0 msec  sec real [(ESG_Start
+60/
1.28e6/S),
(ESG_Start
+32/
1.28/S)]
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ESG_Subframes Subframes to ESG 3   int [0, 1000]

ESG_Power ESG RF ouput power (dBm) -20   real (-∞, ∞)

ESG_ClkRef Waveform clock reference:
Internal, External

Internal   enum  

ESG_ExtClkRefFreq External clock reference freq 10 MHz  Hz real (0, ∞)

ESG_IQFilter IQ filter: through,
filter_2100kHz, filter_40MHz

through   enum  

ESG_SampleClkRate Sequencer sample clock rate 10.24 MHz  Hz real (0, ∞)

ESG_Filename ESG waveform storage
filename

TDSCDMA_UL   string  

ESG_AutoScaling Activate auto scaling? NO,
YES

YES   enum  

ESG_ArbOn Select waveform and turn
ArbOn after download? NO,
YES

YES   enum  

ESG_RFPowOn Turn RF ON after download?
NO, YES

YES   enum  

ESG_EventMarkerType Event marker type: Neither,
Event1, Event2, Both

Event1   enum  

ESG_MarkerLength ESG marker length 10   int [1, 60]

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Setting Parameters
More control of the test bench can be achieved by setting parameters in the Basic
Parameters , Signal Parameters , and measurement categories for the activated
measurements.

Note
For required parameter information, see Set the Required Parameters (adswtbtds).

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
EnableSourceNoise, when set to NO disables the SourceTemp and effectively sets it3.
to -273.15oC (0 Kelvin). When set to YES, the noise density due to SourceTemp is
enabled.
MeasR defines the load resistance for the RF DUT output Meas signal into the test4.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the5.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in6.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in TX test benches (EVM, Constellation, CDP,
PCDE) and results in measurement on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with7.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.
RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out RF signal8.
for RF envelope, ppectrum, ACLR, and occupied bandwidth measurements.
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RF_MirrorFreq is typically set by the user to NO when MirrorSourceSpectrum = NO;
RF_MirrorFreq is typically set by the user to YES when MirrorSourceSpectrum = YES.
Both settings result in viewing the RF_out signal with no spectrum mirroring. Other
settings by the user result in RF_out signal for RF_Envelope and Spectrum
measurements with spectrum mirroring.
MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in RF9.
signal for the RF envelope, spectrum, ACLR, and occupied bandwidth measurements.
MeasMirrorFreq is typically set to NO by the user when the combination of the
MirrorSourceSpectrum value and any signal mirroring in the users RF DUT results in
no spectrum mirroring in the Meas_in signal. MeasMirrorFreq is typically set to YES
by the user when the combination of the MirrorSourceSpectrum and RF DUT results
in spectrum mirroring in the Meas_in signal.
Other settings result in Meas_in signal for RF_Envelope and Spectrum measurements
with spectrum mirroring. The MirrorMeasSpectrum parameter setting has no impact
on the setting or use of the MeasMirrorFreq parameter.

  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
Next, the signal VRF( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip sets the number of samples in a chip.2.
The default value is set to 8 to display settings according to the 3GPP NTDD. It can
be set to a larger value for a simulation frequency bandwidth wider than 8 × 1.28
MHz. It can be set to a smaller value for faster simulation; however, this will result in
lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger
than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 × 1.28
MHz).
RRC_FilterLength sets root raised-cosine (RRC) filter length in chips.3.
The default value is set to 12 to transmit TD-SCDMA downlink signals in time and
frequency domains based on the 3GPP NTDD standard. It can be set to a smaller
value for faster simulation; however, this will result in lower signal fidelity.
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MidambleAllocScheme is used to select the midamble allocation scheme. There are4.
three midamble allocation schemes based on the 3GPP NTDD standard [1], [2]. To
set the MidambleAllocScheme parameter based on the 3GPP NTDD standard [1],
related parameters must be set as stated here.

UE specific midamble allocation : a UE specific midamble for uplink and
downlink is explicitly assigned by higher layers.
if MidambleAllocScheme=UE_Specific, BasicMidambleID, MaxMidambleShift, and
MidambleID are used to specify which midamble is exported.
Common midamble allocation : the midamble for downlink is allocated by
layer 1 depending on the number of channelization codes currently present in
the downlink time slot.
if MidambleAllocScheme=Common, only BasicMidambleID and
MaxMidambleShift are used to specify which midamble is exported; the
MidambleID parameter is ignored.
Default midamble allocation : the midamble for uplink and downlink is
assigned by layer 1 depending on the associated channelization code.
if MidambleAllocScheme=Default, only BasicMidambleID and MaxMidambleShift
are used to specify which midamble is exported; the MidambleID parameter is
ignored.

BasicMidambleID sets the basic midamble code ID. The basic midamble code is used5.
for training sequences for uplink and downlink channel estimation, power
measurements and maintaining uplink synchronization. There are 128 different
sequences; the BasicMidambleID range is 0 to 127. In Signal Studio, Basic Midamble
ID code has the same meaning as this parameter.
MidambleID sets the index of midambles for DPCH. Midambles of different users6.
active in the same cell and the same time slot are cyclically shifted versions of one
basic midamble code.
Let P = 128, the length of basic midamble and K=MaxMidambleShift, then

W = , is the shift between midambles and 
denotes the largest number less than or equal to x. MidambleID range is from 1 to
MaxMidambleShift.
MidambleID and MaxMidambleShift together correspond to the Midamble Offset
parameter in Signal Studio for Timeslot setup. Midamble Offset = MidambleID × W.
MaxMidambleShift is the maximum number of different midamble shifts in a cell that7.
can be determined by maximum users in the cell for the current time slot.
ActiveTimeSlot specifies which slot signal in the subframe will be transmitted.8.
Referring to 12.2 kbps Uplink Channel Subframe Structure (adswtbtds), when
ActiveTimeSlot=2, TS2 is used.
SpreadCode sets the spread code index for the DPCH. For this test bench, the9.
spreading factor is 8.
In Signal Studio, Channelization code for Time slot setup has the same meaning as
SpreadCode.

  

 RF Envelope Measurement Parameters

The RF Envelope measurement is not affected by the MirrorMeasSpectrum parameter. To
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apply spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq=YES. To
apply spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq=YES.

RF_EnvelopeDisplayPages provides Data Display page information for this
measurement. It cannot be changed by the user.
RF_EnvelopeStart sets the start time for collecting input data.
RF_EnvelopeStop sets the stop time for collecting input data when
RF_EnvelopeSubframes=0.
RF_EnvelopeSubframes (when > 0) sets the number of bursts over which data will be
collected.
Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and
RF_EnvelopeSubframes, the stop time may be adjusted.
For RF envelope measurement for the RF_out and Meas_in signals:
Let:
Start = TimeStep× (int(RF_EnvelopeStart/TimeStep) + 0.5)
Stop = TimeStep × (int(RF_EnvelopeStop/TimeStep) + 0.5)
This means Start and Stop are forced to be an integer number of time-step intervals.
RF_EnvelopeSubframes Resultant Stop Time

0 Stop

> 0 Start + RF_EnvelopeSubframes x SubframeTime

For the RF envelope of Meas_in to contain at least one complete Subframe, the Stop
value must be set to a minimum of SubframeTime + (RF DUT time delay).
For information about TimeStep and SubframeTime, see Test Bench Variables for
Data Displays.

  

 Constellation Parameters

The Constellation measurement requires setting the MirrorMeasSpectrum parameter such
that there is an even number of spectrum mirrorings from the combined test bench source
and RF DUT. For example, if MirrorSourceSpectrum=NO and the RF DUT causes its output
RF signal to have spectrum mirroring relative to its input signal, then set
MirrorMeasSpectrum=YES.

ConstellationDisplayPages provides Data Display page information for this1.
measurement. It cannot be changed by the user.
ConstellationSubframes sets the number of subframes over which data will be2.
collected.
The measurement start time is the time when the first subframe is detected in the3.
measured RF signal. Automatic synchronization by the measurement model avoids
any start-up transient in the Constellation plots.

  

 Power Measurement Parameters

PowerDisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
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PowerSubframeMeasured sets the number of subframes over which data will be2.
collected.
The measurement start time is the time when the first subframe is detected in the3.
measured RF signal. Automatic synchronization by the measurement model avoids
any start-up transient in the Constellation plots. The measurement stop time is this
start time plus PowerSubframeMeasured × SubframeTime. SubframeTime is
described in Test Bench Variables for Data Displays.

  

 Spectrum Measurement Parameters

The Spectrum measurement calculates the spectrum of the input signal. Averaging the
spectrum over multiple subframes can be enabled as described in this section.

This measurement is not affected by the MirrorMeasSpectrum parameter. To apply
spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq = YES; to apply
spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq = YES.

In the following, TimeStep denotes the simulation time step and FMeasurement denotes
the measured RF signal characterization frequency.

The measurement outputs the complex amplitude voltage values at the frequencies1.
of the spectral tones. It does not output the power at the frequencies of the spectral
tones. However, one can calculate and display the power spectrum as well as the
magnitude and phase spectrum by using the dBm, mag, and phase functions of the
data display window.
Note that the dBm function assumes a 50-ohm reference resistance; if a different
measurement was used in the test bench, its value can be specified as a second
argument to the dBm function, for example, dBm(SpecMeas, Meas_RefR) where
SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the
resistive load used.
By default, the displayed spectrum extends from FMeasurement - 1/(2×TimeStep) Hz
to FMeasurement + 1/(2×TimeStep) Hz. When FMeasurement < 1/(2×TimeStep),
the default spectrum extends to negative frequencies. The spectral content at these
negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. The negative frequency tones are then displayed on
the positive frequency axis as would happen in an RF spectrum analyzer
measurement instrument. This process may introduce an error in the displayed
frequency for the mirrored tones. The absolute error introduced is less than
(spectrum frequency step) / 2 (see Effect of Values for SpecMeasStart,
SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW for the definition of
spectrum frequency step).
The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple subframes and average the results to
achieve video averaging (see note 6).
SpecMeasDisplayPages provides information regarding Data Display pages for this2.
measurement. It cannot be changed by the user.
SpecMeasStart sets the start time for collecting input data.3.
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SpecMeasStop sets the stop time for collecting input data when SpecMeasSubframes4.
= 0 and SpecMeasResBW = 0.
SpecMeasSubframes sets the number of segments over which data will be collected.5.
SpecMeasResBW sets the resolution bandwidth of the spectrum.6.
Depending on the values of SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and
SpecMeasResBW, the stop time may be adjusted or spectrum video averaging may
occur (or both). The different cases are described in Effect of Values for
SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW.
Referring to Effect of Values for SpecMeasStart, SpecMeasStop, SpecMeasSubframes,
and SpecMeasResBW, let
Start = TimeStep × int((SpecMeasStart/TimeStep) + 0.5)
Stop = TimeStep × int((SpecMeasStop/TimeStep) + 0.5)
(This means Start and Stop are forced to be an integer number of time step
intervals.)
X = normalized equivalent noise bandwidth of the window
Start and Stop times are used for RF_out and Meas_in signal spectrum analyses. The
Meas_in signal is delayed in time from the RF_out signal by the value of the RF DUT
time delay. Therefore, for RF DUT time delay >0, the RF_out and Meas_in signals are
inherently different and spectrum display differences can be expected.
TimeStep and SubframeTime are defined in the Test Bench Variables for Data
Displays section.
Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular
filter. It is the equivalent width of a rectangular filter that passes the same amount of
white noise as the window. Normalized ENBW (NENBW) is ENBW multiplied by the
duration of the signal being windowed. (Refer to note 7 regarding the various window
options and Window Options and Normalized Equivalent Noise Bandwidth regarding
NENBW for the various windows.)

 Effect of Values for SpecMeasStart, SpecMeasStop, SpecMeasSubframes, and SpecMeasResBW  
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Case
1

SpecMeasSubframes = 0
SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case
2

SpecMeasSubframes > 0
SpecMeasResBW = 0
Resultant stop time = Start + SpecMeasSubframes x SubframeTime
For SpecMeasSubframes > 0 and SpecMeasResBW = 0
Video averaging occurs over all segment time intervals
Resultant resolution BW = X /SubframeTime
Resultant spectrum frequency step = 1/SubframeTime
Video averaging status = Yes, when SpecMeasSubframes > 1

Case
3

SpecMeasSubframes = 0
SpecMeasResBW > 0
Resultant stop time = Start + N x SubframeTimeInterval
where
N = int((Stop -Start)/SubframeTimeInterval) + 1
For SpecMeasSubframes = 0 and SpecMeasResBW > 0
Define SubframeTimeInterval = TimeStep x int((X/SpecMeasResBW/TimeStep) + 0.5)
This means SubframeTimeInterval is forced to a value that is an integer number of time step
intervals.
(Stop-Start) time is forced to be an integer number (N) of SubframeTimeIntervals
N has a minimum value of 1
Video averaging occurs over all SubframeTimeIntervals
Resolution bandwidth achieved is ResBW = X / SubframeTimeInterval, which is very close to
SpecMeasResBW but may not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact
integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case
4

SpecMeasSubframes > 0
SpecMeasResBW > 0
Resultant stop time = Start + M x SubframeTimeInterval
where
M = int((SpecMeasSubframes x SubframeTime)/SubframeTimeInterval) + 1
For SpecMeasSubframes > 0 and SpecMeasResBW > 0
Define SubframeTimeInterval = TimeStep x int(( X /SpecMeasResBW/TimeStep) + 0.5)
This means SubframeTimeInterval is forced to a value that is an integer number of time step
intervals.
(Stop-Start) time is forced to be an integer number (M) of the SubframeTimeIntervals
M has a minimum value of 1
Video averaging occurs over all SubframeTimeIntervals
Resolution bandwidth achieved is ResBW = X / SubframeTimeInterval, which is very close to
SpecMeasResBW but may not be exactly the same if X/SpecMeasResBW/TimeStep is not an exact
integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

SpecMeasWindow specifies the window that will be applied to each segment before7.
its spectrum is calculated. Different windows have different properties, affect the
resolution bandwidth achieved, and affect the spectral shape. Windowing is often
necessary in transform-based (chirp-Z, FFT) spectrum estimation in order to reduce
spectral distortion due to discontinuous or non-harmonic signal over the
measurement time interval. Without windowing, the estimated spectrum may suffer
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from spectral leakage that can cause misleading measurements or masking of weak
signal spectral detail by spurious artifacts.
The windowing of a signal in time has the effect of changing its power. The spectrum
measurement compensates for this and the spectrum is normalized so that the power
contained in it is the same as the power of the input signal.
Window Type Definitions:

none

where N is the window size
Hamming 0.54

where N is the window size
Hanning 0.50

where N is the window size
Gaussian 0.75

where N is the window size
Kaiser 7.865

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
8510 6.0 (Kaiser 6.0)

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
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Blackman

where N is the window size
Blackman-Harris

where N is the window size.

 Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant NENBW

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021

  

 EVM Measurement Parameters

The EVM measurement requires setting the MirrorMeasSpectrum parameter such that
there is an even number of spectrum mirrorings from the combined test bench source and
RF DUT. For example, if MirrorSourceSpectrum=NO and the RF DUT causes its output RF
signal to have spectrum mirroring relative to its input signal, then set
MirrorMeasSpectrum=YES.
The EVM measurement provides results for EVM, magnitude error, phase error for one
code channel and for the composite signal. It also provides rho, frequency error, IQ offset,
and gain imbalance.

EVM_DisplayPages provides information regarding Data Display pages for this1.
measurement. It cannot be changed by the user.
Starting at the time instant specified by EVM_StartTime, a signal segment of 10msec2.
is captured and the beginning of a subframe is detected (a 10msec signal segment is
guaranteed to contain a whole subframe). After the subframe is detected, the I and Q
envelopes of the input signal are extracted. The I and Q envelopes are then passed
to a complex algorithm that performs synchronization, demodulation, and EVM
analysis (this algorithm is the same as the one used in the Agilent 89600 VSA).
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If EVM_AverageType is set to Off, only one subframe is detected, demodulated, and3.
analyzed.
If EVM_AverageType is set to RMS (Video), after the first subframe is analyzed the
signal segment corresponding to it is discarded and new signal samples are collected
from the input to fill in the 10msec signal buffer. When the buffer is full again a new
subframe is detected, demodulated, and analyzed. These steps are repeated until
EVM_SubframesToAverage subframes are processed.
If a subframe is mis-detected for any reason, results from its analysis are discarded.
EVM results obtained from all the successfully detected, demodulated, and analyzed
subframes are averaged to give the final averaged results. EVM results from each
successfully analyzed subframe are also recorded (in the variables without the Avg_
prefix in their name).
EVM_ActiveSlotThreshold sets the active slot detection threshold; that is the power4.
level (in dB with respect to the power level of the slot with the largest measured
power) below which a slot will be considered as inactive.

  

 Signal to ESG Parameters

The EVM measurement collects data from the Meas_in signal and downloads it to an
Agilent E4438C Vector Signal Generator. This measurement uses Connection Manager
architecture to communicate with the instrument; parameters specify how data is
interpreted.
Prerequisites for using the Signal to ESG option are:

ESG Vector Signal Generator E4438C; for information, visit the web site
http://www.agilent.com/find/esg .
PC workstation running an instance of the connection manager server.
Supported method of connecting the instrument to your computer through the
Connection Manager architecture; for information, see Connection Manager .

 

 Parameter Information

EnableESG specifies if the signal is downloaded to the ESG instrument. If set to NO,1.
no attempt will be made to communicate with the instrument.
ESG_Instrument specifies a triplet that identifies the VSA resource of the instrument2.
to be used in the simulation, the connection manager server hostname (defaults to
localhost ), and the port at which the connection manager server listens for incoming
requests (defaults to 4790). To ensure that this field is populated correctly, click
Select Instrument , enter the server hostname and port, click OK to see the Remote
Instrument Explorer dialog, select a VSA resource identifier, and click OK . For details
about selecting instruments, see Instrument Discovery in the Wireless Test Bench
Simulation documentation.
ESG_Start and ESG_Stop (when ESG_Subframes=0) specify when to start and stop3.
data collection. The number of samples collected, ESG_Stop - ESG_Start + 1, must
be in the range 60 samples to 64 Msamples, where 1 Msample = 1,048,576 samples.

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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The ESG requires an even number of samples; the last sample will be discarded if
ESG_Stop - ESG_Start + 1 is odd.
ESG_Subframes sets the number of subframes over which data will be collected. If4.
ESG_Subframes is greater than zero, then ESG_Stop is forced to ESG_Start +
ESG_Subframes x SubframeTime where SubframeTime is 5 msec.
ESG_ClkRef specifies an internal or external reference for the ESG clock generator. If5.
set to External, the ESG_ExtClkRefFreq parameter sets the frequency of this clock.
ESG_IQFilter specifies the cutoff frequency for the reconstruction filter that lies6.
between the DAC output and the Dual Arbitrary Waveform Generator output inside
the ESG.
ESG_SampleClkRate sets the sample clock rate for the DAC output.7.
ESG_Filename sets the name of the waveform inside the ESG that will hold the8.
downloaded data.
The ESG driver expects data in the range {-1, 1}. The ESG_AutoScaling parameter9.
specifies whether to scale inputs to fit this range. If set to YES, inputs are scaled to
the range {-1, 1}; if set to NO, raw simulation data is downloaded to the ESG
without any scaling, but data outside the range {-1, 1} is clipped to -1 or 1. If set to
YES, scaling is also applied to data written to the local file (ESG_Filename setting).
If ESG_ArbOn is set to YES, the ESG will start generating the signal immediately after10.
simulation data is downloaded; if set to NO, waveform generation must be turned on
at the ESG front panel.
If ESG_RFPowOn is set to YES, the ESG will turn RF power on immediately after11.
simulation data is downloaded. If ESG_RFPowOn is set to NO (default), RF power
must be turned on at the ESG front panel.
ESG_EventMarkerType specifies which ESG Event markers are enabled: Event1,12.
Event2, Both, or Neither. Event markers are used for synchronizing other instruments
to the ESG. When event markers are enabled, Event1 or Event2 (or both) is set
beginning from the first sample of the downloaded Arb waveform over the range of
points specified by the ESG_MarkerLength parameter. This is equivalent to setting
the corresponding event from the front panel of the ESG.
ESG_MarkerLength specifies the range of points over which the markers must be set13.
starting from the first point of the waveform. Depending on the
ESG_EventMarkerType setting, the trigger length of Event1 or Event2 (or both) is set
to a multiple of the pulsewidth that, in turn, is determined by the sample clock rate
of the DAC output.
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 Simulation Measurement Displays
After running the simulation, results are displayed in Data Display pages for each
measurement activated.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for TD-SCDMA Wireless
Test Benches (adswtbtds).

 

 RF Envelope Measurement

 The RF Envelope measurement (not defined in 3GPP TS 25) shows the envelope of a TD-
SCDMA uplink signal. Measurements for the RF signal at the input of the RF DUT and the
Meas signal at the output of the RF DUT are implemented.

The real and imaginary parts of the RF and Meas signals are shown in RF Envelope
Simulation Results. There are two active parts because ActiveTimeslot is set to TS1 and
uplink pilot is transmitted. Only 2.6msec of data is stored to save disk space; the stop
time can be changed by setting RF_EnvelopeMeasurement parameters.

 

 RF Envelope Simulation Results
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 Constellation Measurement

 The constellation measurement (not defined in 3GPP TS 25) shows the constellation of
one code channel of the TD-SCDMA uplink signal. The constellation for the RF and Meas
signals are shown in Signal Constellations. Through the constellation measurement,
distortion caused by carrier phase shift, IQ imbalance, and phase noise can be observed.
Comparing the RF and the Meas signals, the constellation of the Meas signal rotates a
fixed angle due to the delay introduced by the DUT.

QPSK demodulation is implemented in the TD-SCDMA uplink. Symbol mapping is shown in
Symbol Mapping.

 

 Signal Constellations

*Input <th

00 +j

01 +1

10 -1

11 -j

 

 Power Measurement

 The power measurement includes: power vs. time (defined in 3GPP TS 25.102 [3] and TS
34.122 [4]); and, CCDF (not defined in 3GPP standards).

Power vs. time is the instant power of chips in the subframe (when
PowerSubframeMeasured = 1) and average power of chips at the same position in all
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measured subframes (when PowerSubframeMeasured > 1). CCDF fully characterizes the
power statistics of a signal and provides characterization of peak-to-average power ratio
versus probability.

The on/off mask template for power vs. time is illustrated in Uplink Transmit On/Off Mask
Template.

Results of power vs. time for the RF and Meas signals are shown in Power vs. Time in One
Subframe; results of power vs. time with masks are shown in RF and Signal Power vs.
Time with Masks.

To show the power vs. time on/off masks more clearly, zoomed-in RF and Meas signals
are shown in RF Signal Power vs. Time with Masks Off and On and Meas Signal Power vs.
Time with Masks Off and On.

If the curves meet the masks, Pass will show in the Data Display window.

 

 Uplink Transmit On/Off Mask Template

 

 Power vs. Time in One Subframe
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 RF and Signal Power vs. Time with Masks

 

 RF Signal Power vs. Time with Masks Off and On

 

 Meas Signal Power vs. Time with Masks Off and On
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The CCDF for the RF and the Meas signals are shown in Complementary Cumulative
Distribution Function.

The peak-to-average power ratios of the RF and Meas signals are shown in Peak-to-
Average Power Ratios.

 

 Complementary Cumulative Distribution Function

 

 Peak-to-Average Power Ratios

 

 Spectrum Measurement

 The spectrum measurement (not defined in 3GPP standards) shows the spectrum of the
TD-SCDMA uplink signal. The spectrum analyzer output contain complex amplitude
voltage values and the dBm(<meas_name>, <ref_r>) expressions can be used to convert
to dBm values. Spectrums for the RF and the Meas signals are shown in TD-SCDMA Signal
Spectrums.
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 TD-SCDMA Signal Spectrums

 

 EVM Measurement

The EVM measurement (defined in 3GPP TS 25.102 and TS 34.122) demonstrates the
uplink EVM measurement. EVM is a measure of the difference between the reference and
the measured waveform; this difference is called the error vector. Both waveforms pass
through a matched root raised-cosine filter with bandwidth corresponding to the
considered chip rate and roll-off a=0.22. Both waveforms are further modified by selecting
the frequency, absolute phase, absolute amplitude, and chip clock timing so as to
minimize the error vector. The EVM result is defined as the square root of the ratio of the
mean error vector power to the mean reference power expressed as a percent. The
measurement interval is one timeslot.

The EVM must not exceed 17.5%. The requirement is valid over the total power dynamic
range as specified in subclause 6.4.3 of TS 25.102.

 The results from this measurement are described in EVM Measurement Results.
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Result Description

Avg_ChEVMrms_pct average channel EVM rms in %

ChEVMrms_pct channel EVM rms in % versus subframe

ChEVM_Pk_pct channel peak EVM in % versus subframe

ChEVM_Pk_symbol_idx channel peak EVM symbol index versus subframe

Avg_ChMagErr_rms_pct average channel magnitude error rms in %

ChMagErr_rms_pct channel magnitude error rms in % versus subframe

ChMagErr_Pk_pct channel peak magnitude error in % versus subframe

ChMagErr_Pk_symbol_idx channel peak magnitude error symbol index versus subframe

Avg_ChPhaseErr_deg average channel phase error in degrees

ChPhaseErr_deg channel phase error in degrees versus subframe

ChPhaseErr_Pk_deg channel peak phase error in degrees versus subframe

ChPhaseErr_Pk_symbol_idx channel peak phase error symbol index versus subframe

ChCodePhase_deg channel code phase (phase of the channel code with respect to the pilot) versus
subframe

Avg_CompEVMrms_pct average composite EVM rms in %

CompEVMrms_pct composite EVM rms in % versus subframe

CompEVM_Pk_pct composite peak EVM in % versus subframe

CompEVM_Pk_chip_idx composite peak EVM chip index versus subframe

Avg_CompMagErr_rms_pct average composite magnitude error rms in %

CompMagErr_rms_pct composite magnitude error rms in % versus subframe

CompMagErr_Pk_pct composite peak magnitude error in % versus subframe

CompMagErr_Pk_chip_idx composite peak magnitude error chip index versus subframe

Avg_CompPhaseErr_deg average composite phase error in degrees

CompPhaseErr_deg composite phase error in degrees versus subframe

CompPhaseErr_Pk_deg composite peak phase error in degrees versus subframe

CompPhaseErr_Pk_chip_idx composite peak phase error chip index versus subframe

Avg_Rho average rho

Rho rho versus subframe

Avg_FreqError_Hz average frequency error in Hz

FreqError_Hz frequency error in Hz versus subframe

Avg_IQ_Offset_dB average IQ offset in dB

IQ_Offset_dB IQ offset in dB versus subframe

Avg_QuadErr_deg average quadrature error in degrees

QuadErr_deg quadrature error in degrees versus subframe

Avg_GainImb_dB average IQ gain imbalance in dB

IQ_GainImb_dB IQ gain imbalance in dB versus subframe

If EVM_AverageType is set to RMS (Video), EVM will be measured in
EVM_SubframesToAverage subframes. If EVM_AverageType is set to Off, EVM will be
measured in the first subframe detected. Results named with the Avg_ prefix are results
averaged over the number of subframes specified by the user in
EVM_SubframesToAverage (when EVM_AverageType is set to RMS (Video)). Results that
are not named Avg_ are results versus subframe. RF signal results are shown in RF Signal
Average and Peak EVM; Meas signal results are shown in Meas Signal Average and Peak
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EVM.

 

 RF Signal Average and Peak EVM

 

 Meas Signal Average and Peak EVM

RF signal results for averaged EVM, magnitude error, and phase error of one code channel
and composite channel are shown in RF Signal EVM, Magnitude Error, and Phase Error
Results; Meas signal results are shown in Meas Signal EVM, Magnitude Error, and Phase
Error Results. According to the 3GPP standard, the EVM must not exceed 17.5%; EVM
results for the RF and the Meas signals meet specification requirements.
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 RF Signal EVM, Magnitude Error, and Phase Error Results

 

 Meas Signal EVM, Magnitude Error, and Phase Error Results

 

 Test Bench Variables for Data Displays

 Reference variables used to set up this test bench are listed in Test Bench Equations
Derived from Test Bench Parameters and Exported to Data Display.
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Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10 × log10(SourcePower)+30

RF_R SourceR

TimeStep 1/(ChipRate × SamplesPerChip)

ActiveSlot ActiveTimeslot

SubframeTime 5 msec

FilterLength RRC_FilterLength

Meas_FMeasurement FMeasurement

Meas_R MeasR
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one TD-SCDMA uplink subframe is a function of
SamplesPerChip and ChipRate.
SamplesPerChip = 8
ChipRate = 1.28 Mb/s
Resultant WTB_TimeStep = 97.65625 nsec; SubframeTime = 5msec; time
points per subframe = 51200.

Simulation times and memory requirements:
TDSCDMA_UpLnk_TX
Measurement

Bursts
Measured

Simulation Time
(sec)

ADS Processes
(MB)

RF_Envelope 1 19 91

Constellation 3 25 129

Power 3 197 122

Spectrum 3 24 140

EVM 3 11 104

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 References for Uplink Transmitter Test
3GPP TS 25.221, "3rd Generation Partnership Project; Technical Specification Group1.
Radio Access Network; Physical channels and mapping of transport channels onto
physical channels (TDD) (Release 4)," version 4.5.0, June, 2002.
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25221-450.zip ]
3GPP TS 25.223, "3rd Generation Partnership Project; Technical Specification Group2.
Radio Access Network; Spreading and modulation (TDD) (Release 4)," version 4.4.0,
March, 2002.
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25223-440.zip ]
3GPP TS 25.102, "3rd Generation Partnership Project; Technical Specification Group3.
Radio Access Networks; UE Radio Transmission and Reception (TDD) (Release 4),"
version 4.5.0, June, 2002.
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25102-450.zip ]
3GPP TS 34.122, "3rd Generation Partnership Project; Technical Specification Group4.
Terminal; Terminal Conformance Specification; Radio Transmission and Reception
(TDD) (Release 4)," version 4.4.0, June, 2002.
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/34_series/34122-440.zip ]

Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform analysis
tasks.

Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.

Setting Automatic Verification Modeling Parameters in the Wireless Test Bench Simulation
documentation explains how to improve simulation speed.

http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25221-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25221-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25223-440.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25223-440.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25102-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/25_series/25102-450.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/34_series/34122-440.zip
http://www.3gpp.org/ftp/Specs/2002-06/Rel-4/34_series/34122-440.zip
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